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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed 
as constituting an additional warranty. HP shall not be liable for technical or editorial errors 
or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or 
copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 
Computer Software Documentation, and Technical Data for Commercial Items are licensed 
to the U.S. Government under vendor's standard commercial license.

Third-Party Web Sites

HP provides links to external third-party Web sites to help you find supplemental 
information.  Site content and availability may change without notice.  HP makes no 
representations or warranties whatsoever as to site content or availability.

Copyright Notices

© Copyright 1993 - 2007 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Intel® and Pentium® are trademarks or registered trademarks of Intel Corporation or its 
subsidiaries in the United States and other countries.

JavaTM is a US trademark of Sun Microsystems, Inc.

Microsoft®, Windows®, and Windows XP® are U.S registered trademarks of Microsoft 
Corporation.

Oracle® is a registered U.S trademark of Oracle Corporation, Redwood City, California.

Red HatTM is a registered trademark of Red Hat, Inc.

Unix® is a registered trademark of The Open Group.
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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (http://
h20230.www2.hp.com/svi_partner_list.jsp), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web 
site and use the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products 
formerly produced by Mercury, we encourage you to visit the Mercury Customer Support 
Web site at: http://support.mercury.com.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

http://support.mercury.com
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
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Welcome to This Guide

Welcome to HP Quality Center, the HP Web-based quality management 
solution. Quality Center helps you organize and manage all phases of the 
application testing process, including defining releases, specifying 
requirements, planning tests, executing tests, and tracking defects.

How This Guide is Organized

The Quality Center Installation Guide describes the system requirements 
and installation process for Quality Center. 

It contains the following chapters:

Chapter 1 Before You Install

Provides an overview of the product, and specifies the system configurations 
for installing Quality Center. In addition, it provides an installation 
checklist and other related information to help make sure that you are fully 
prepared before starting the installation process.

Chapter 2 Installing Quality Center

Describes how to install Quality Center.

Chapter 3 Manually Deploying Quality Center on WebLogic

Describes how to manually deploy Quality Center on the WebLogic 
application server.
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Chapter 4 Manually Deploying Quality Center on WebSphere

Describes how to manually deploy Quality Center on the WebSphere 
application server.

Chapter 5 Manually Integrating JBoss with Apache

Describes how to manually configure the Apache Web server to redirect 
requests to JBoss.

Chapter 6 Getting Started 

Describes the contents of the Quality Center program folder, how to start 
and stop Quality Center services, and how to log in to Quality Center.

Chapter 7 Installing Quality Center Add-ins

Describes how to install Quality Center integrations with HP testing tools, 
and with third-party, synchronization and version control tools.

Chapter 8 Verifying the IIS Configuration

Describes how to verify the Internet Information Server component settings.

Chapter 9 Customizing Quality Center

Describes how to customize the names of Quality Center modules, various 
links, and Tools and Help menus.

Chapter 10 Changing the JBoss Heap Memory Size and Port

Describes how to change the default heap memory value and port number 
for a JBoss application server.

Chapter 11 Uninstalling Quality Center

Describes how to uninstall Quality Center from your server machine, and to 
uninstall the client application.

Appendix A Troubleshooting Quality Center Installation

Troubleshooting suggestions for dealing with issues relating to the 
Quality Center installation.



Welcome to This Guide

9

Documentation Library

The Documentation Library is an online help system that describes how to 
use Quality Center. You can access the Documentation Library in the 
following ways:

➤ Click Documentation Library in the Quality Center Help menu to open the 
Documentation Library home page. The home page provides quick links to 
the main help topics.

➤ Click Help on this page in the Quality Center Help menu to open the 
Documentation Library to the topic that describes the current page.
 

Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

Getting Started explains how to use the Documentation Library and how it 
is organized. (Available online.)

What’s New? describes the newest features in the latest version of 
Quality Center. (Available online and in PDF format.)

You can also access What’s New? from the Quality Center Help menu. In 
addition, you can choose Help > Product Feature Movies to view short 
movies that demonstrate the main product features. 

Readme provides last-minute news and information about Quality Center. 

Quality Center Guides

HP Quality Center User’s Guide explains how to use Quality Center to 
organize and execute all phases of the testing process. It describes how to 
define requirements, plan tests, run tests, and track defects. (Available 
online and in PDF format.)

HP Quality Center Administrator’s Guide explains how to create and 
maintain projects using Site Administration, and how to customize projects 
using Project Customization. (Available online and in PDF format.)

http://www.adobe.com
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HP Quality Center Tutorial is a self-paced guide teaching you how to use 
Quality Center to manage the software testing process. (Available in PDF 
format.)

HP Quality Center Installation Guide explains how to install Quality Center 
on a server machine in a cluster environment or as a stand-alone 
application. (Available in PDF format.)

Business Process Testing Guides

HP Business Process Testing User’s Guide explains how to use Business 
Process Testing to create business process tests. (Available online and in PDF 
format.)

HP Business Process Testing Tutorial provides a self-paced guide that teaches 
you the basics of Business Process Testing in the Quality Center application. 
(Available in PDF format.)

API References

HP Quality Center Database Reference provides a complete online reference 
for the project database tables and fields. (Available online.)

HP Quality Center Open Test Architecture API Reference provides a 
complete online reference for the Quality Center COM-based API. You can 
use the Quality Center open test architecture to integrate your own 
configuration management, defect tracking, and home-grown testing tools 
with a Quality Center project. (Available online.)

HP Quality Center Site Administration API Reference provides a complete 
online reference for the Site Administration COM-based API. You can use 
the Site Administration API to enable your application to organize, manage, 
and maintain Quality Center users, projects, domains, connections, and site 
configuration parameters. (Available online.)

HP Quality Center Custom Test Type Guide provides a complete online 
guide for creating your own testing tool and integrating it into the Quality 
Center environment. (Available online.)

  



Welcome to This Guide

11

Additional Online Resources

The following additional online resources are available from the 
Quality Center Help menu:

Knowledge Base opens directly to the Knowledge Base landing page on the 
Mercury Customer Support Web site. Choose Help > Knowledge Base. The 
URL for this Web site is support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp.

Customer Support Web site accesses the Mercury Customer Support Web 
site. This site enables you to browse the Mercury Support Knowledge Base 
and add your own articles. You can also post to and search user discussion 
forums, submit support requests, download patches and updated 
documentation, and more. Choose Help > Customer Support Web site. The 
URL for this Web site is support.mercury.com.

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Add-ins Page opens the HP Quality Center Add-ins Page, which offers 
integrations with HP testing tools, as well as third-party, synchronization, 
and version control tools. For more information, refer to the 
HP Quality Center Installation Guide.

  

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com
www.hp.com/go/software
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Typographical Conventions

This guide uses the following typographical conventions:

UI Elements and 
Function Names

This style indicates the names of interface elements on 
which you perform actions, file names or paths, and 
other items that require emphasis. For example, “Click 
the Save button.” It also indicates method or function 
names. For example, "The wait_window statement has 
the following parameters:"

Arguments This style indicates method, property, or function 
arguments and book titles. For example, “Refer to the 
HP User’s Guide.”

<Replace Value> Angle brackets enclose a part of a file path or URL 
address that should be replaced with an actual value. 
For example, <MyProduct installation folder>\bin.

Example This style is used for examples and text that is to be 
typed literally. For example, “Type Hello in the edit 
box.”

CTRL+C This style indicates keyboard keys. For example, “Press 
ENTER.”

[ ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument. 

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. In a 
programming example, an ellipsis is used to indicate 
lines of a program that were intentionally omitted.

| A vertical bar indicates that one of the options 
separated by the bar should be selected.
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1
Before You Install

This chapter provides an overview of the installation process, and specifies 
the requirements for installing Quality Center.

This chapter includes:

 ➤  About the Quality Center Technology on page 14

 ➤  The Installation Process on page 16

 ➤  System Configurations on page 18

 ➤  Installation Checklist on page 24

 ➤  Quality Center Server-Side Prerequisites on page 26

 ➤  Quality Center Client-Side Prerequisites on page 43

 ➤  Working with Previously Created Projects on page 46

 ➤  Text Search Configuration on page 48
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About the Quality Center Technology

Quality Center is an enterprise-wide application that is based on Java 2, 
Enterprise Edition (J2EE) technology. J2EE technology provides a 
component-based approach to the design, development, assembly, and 
deployment of enterprise applications. Within the J2EE framework, 
Quality Center supports clustering. A cluster is a group of application servers 
that run Quality Center as if they were a single entity. Each application 
server in a cluster is referred to as a node or a cluster node.

Clusters provide mission-critical services to ensure maximum scalability and 
high availability. The load balancing technique within the cluster is used to 
distribute client requests across multiple application servers, making it easy 
to scale to an infinite number of users. The cluster of servers can run on 
Windows, Linux, Solaris, and AIX based platforms.

The following diagram illustrates how Quality Center client requests are 
transmitted within a cluster.
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➤ HP Quality Center Client. When users log in to Quality Center or Site 
Administration from their client machine, client components are 
downloaded to their client machine. Quality Center uses the Component 
Object Model (COM) interface as an interprocess communicator among the 
components. 

➤ Internet. Client requests are transmitted via the HTTP protocol to the server.

➤ Load Balancer. When working with a load balancer, client requests are 
transmitted to the load balancer and distributed according to server 
availability within the cluster.

➤ Application Server. Client requests are dispatched by servlets to the 
deployed Quality Center application on the application server. 
Quality Center supports JBoss, WebLogic, and WebSphere. 

The deployed application contains Quality Center, Site Administration, and 
associated files which are packaged into Web Application Archive (WAR) 
files. Client requests from Quality Center are dispatched to the QCBin.war 
file. Client requests from Site Administration are dispatched to the 
SABin.war file.

The Java Database Connectivity (JDBC) interface is used to communicate 
between the application server and the databases.

➤ Databases. The Quality Center schema stores project information. The Site 
Administration schema stores domain, project, and user data. The schemas 
can reside on Oracle or Microsoft SQL Server.
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The Installation Process

Installing Quality Center includes the following steps:

Verify System Configurations
Before you install Quality Center, verify that your server and client 
machines meet hardware and software specifications. To verify system 
specifications for Quality Center, see “System Configurations” on page 18. 

In addition to verifying the system specifications, ensure that you have all 
the information for installing Quality Center on a server machine (see 
“Installation Checklist” on page 24). For more information on the 
privileges, permissions, and other information required to install and run 
Quality Center, see “Quality Center Server-Side Prerequisites” on page 26 
and “Quality Center Client-Side Prerequisites” on page 43. 

To work with previously created projects, you must upgrade or migrate them 
to your current version of Quality Center. For more information, see 
“Working with Previously Created Projects” on page 46.
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Install Quality Center
Install Quality Center on your server. You can install Quality Center on one 
of the following platforms: Windows, Solaris, Linux, or AIX. For more 
information, see Chapter 2, “Installing Quality Center.”

If you are using JBoss, Quality Center is automatically deployed on your 
application server. If you are using a WebLogic or WebSphere application 
server, you must deploy Quality Center manually. For more information, see 
Chapter 3, “Manually Deploying Quality Center on WebLogic” or 
Chapter 4, “Manually Deploying Quality Center on WebSphere.”

To use Quality Center with an Apache Web server, you need to manually 
configure the Apache Web server to redirect requests to the JBoss application 
server. For more information, see Chapter 5, “Manually Integrating JBoss 
with Apache.”

For information on how to uninstall Quality Center from your server 
machine, see Chapter 11, “Uninstalling Quality Center.”

Start Quality Center
After you install Quality Center, you can launch it from your Web browser. 
For more information, see Chapter 6, “Getting Started.”

Customize and Configure Quality Center 
You can customize and configure Quality Center as follows:

➤ You can install Quality Center add-ins to enhance the existing functionality. 
For more information, see Chapter 7, “Installing Quality Center Add-ins.”

➤ You can customize the names of the Quality Center modules, and the Tools 
and Help menus. For more information, see Chapter 9, “Customizing 
Quality Center”.

➤ You can update the heap memory value on the JBoss application server if 
there is a change in the number of active projects or concurrent user 
sessions in Quality Center. You can also change the JBoss default port 
number. For more information, see Chapter 10, “Changing the JBoss Heap 
Memory Size and Port”.
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➤ If you encounter a problem in the Internet Information Server (IIS) 
component after you install Quality Center on Windows, you should check 
the IIS configuration settings. For more information, see Chapter 8, 
“Verifying the IIS Configuration”.

➤ Additional suggestions for dealing with issues relating to the Quality Center 
installation are described in Appendix A, “Troubleshooting Quality Center 
Installation”.

System Configurations

This section describes the system configurations required for installing 
Quality Center.

Important: Refer to http://www.mercury.com/us/products/quality-
center/testdirector/requirements.html for the most updated Quality Center 
system configurations.

This section includes the following topics:

➤ Server System Configurations on page 19

➤ Client System Configurations on page 21

➤ Citrix Configurations on page 23

➤ VMware ESX Configurations on page 23

http://www.mercury.com/us/products/quality-center/testdirector/requirements.html
http://www.mercury.com/us/products/quality-center/testdirector/requirements.html
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Server System Configurations
This section describes the server system configurations for installing 
Quality Center on Windows, Linux, Solaris, and AIX.

CPU

Windows: Pentium IV or equivalent x86 compatible processor

Linux: Pentium IV or equivalent x86 compatible processors

Solaris: UltraSPARC-III+ / 900 MHz

AIX: Version  5.3

Memory (RAM)

1 GB minimum (2 GB memory for AIX)

Note: Additional memory may be required if you increase the 
default JBoss heap size.

Free Disk Space 3 GB minimum

Database

➤ Oracle 9.2.0.6 Standard/Enterprise Edition

➤ Oracle 10.0g Release 2 Standard/Enterprise Edition

➤ Microsoft SQL Server 2000 Standard/Enterprise Edition 
with Service Pack 4 

➤ Microsoft SQL Server 2005 Standard/Enterprise Edition 
with Service Pack 1

➤ MSDE 2000 Release A (Limited up to 2 GB of memory. 
Supports up to 5 concurrent users.)

Web Server

➤ IIS 6.0 (Windows with JBoss application server only)

➤ Apache 2.0.54

➤ JBoss, WebLogic, or WebSphere HTTP server included with 
the application server
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Operating System Application Server Java Virtual Machine

Windows 2000 Server 
with Service Pack 4

or

Windows 2003 Server 
with Service Pack 1 
Standard/Enterprise 
Edition

JBoss 4.0.2 (included 
with Quality Center)

JVM 1.5

WebLogic 8.1.5 ➤ BEA JRockit 1.4.2_04-
8130

➤ Sun SDK 1.4.2_04

WebSphere 5.1.1.8 IBM Java 1.4.2.04

WebSphere 6.1 IBM Java 1.4.2.05

Red Hat Enterprise
Linux AS/ES, version 3

or

Red Hat Enterprise
Linux AS/ES, version 4

Note: Quality Center 
supports Red Hat 
Enterprise Linux on Intel-
based systems only.

JBoss 4.0.2 (included 
with Quality Center)

JVM 1.5

WebLogic 8.1.5 ➤ BEA JRockit 1.4.2_04-
8130

➤ Sun SDK 1.4.2_04

WebSphere 5.1.1.8 IBM Java 1.4.2.04

WebSphere 6.1 IBM Java 1.4.2.05

SUSE Linux Enterprise 
Server 10

JBoss 4.0.2 (included 
with Quality Center)

JVM 1.5

WebSphere 5.1.1.8 IBM Java 1.4.2.04

WebSphere 6.1 IBM Java 1.4.2.05

Solaris 9 OE

or

Solaris 10 OE

Note: Quality Center 
supports Solaris on 
SPARC-based systems 
only. 

JBoss 4.0.2 (included 
with Quality Center)

JVM 1.5

WebLogic 8.1.5 ➤ BEA JRockit 1.4.2_04-
8130

➤ Sun SDK 1.4.2_04

WebSphere 5.1.1.8 IBM Java 1.4.2.04 

WebSphere 6.1 IBM Java 1.4.2.05

AIX 5.3 WebSphere 5.1.1.8 IBM Java 1.4.2.04

WebSphere 6.1 IBM Java 1.4.2.05
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Notes: 

➤ You can configure JBoss and WebLogic to work with HTTPS. For more 
information, refer to the Customer Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), and select 
TestDirector for Quality Center. For JBoss, search for Article Number 
40463. For WebLogic, search for Article Number 47907.

➤ In Linux, Solaris, and AIX environments, verify that you have a 
supported kernel by running uname -a.

Client System Configurations
This section describes the client system configurations for Quality Center:

CPU Pentium III (or higher) or equivalent x86 compatible processor

Memory (RAM) 512 MB minimum

Free Disk Space 300 MB minimum

Operating 
System

➤ Windows 2000 Server/Professional with SP4

➤ Windows XP 32-bit Professional/Home Edition with SP2

Notes: 

➤ If you are integrating Quality Center with other HP testing 
tools, you must modify the DCOM permissions on your 
client machine. For more information, refer to the 
Customer Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/
kbBrowse.jsp), select TestDirector for Quality Center, and 
search for Article Number 33501.

➤ You can work with the Quality Center client using a remote 
desktop.

Client Software Microsoft .NET Framework 2.0 or later

Display ➤ Color palette setting of 256 colors or higher 
(65536 colors or higher recommended)

➤ Resolution 1024x768 minimum

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Notes: 

➤ Quality Center client-side installation is packaged in Windows Installer 
(MSI) format, and is available from the \Utilities\ClientSideInstallation 
folder on the installation DVD. This facilitates MSI package 
customization for customers using remote or mass distribution 
mechanisms.

➤ If a user connects using a terminal server to a machine running a 
Quality Center client on Windows 2000 Server, the color depth is 
downgraded. This is a Windows 2000 Server limitation that restricts the 
color palette of Terminal Server clients to 256 colors. For greater color 
depth, you should install MetaFrame and use the ICA protocol on 
Windows 2000 Terminal Server, or upgrade to Windows 2003 Server.

Browser ➤ Microsoft Internet Explorer 6.0 with SP1

➤ Microsoft Internet Explorer 7.0 

➤ Quality Center Explorer

Microsoft Word The Document Generator, rich text for requirements, and Risk-
Based Quality Management reports are available only if 
Microsoft Word 2000, XP, or 2003 is installed on your 
machine.

Microsoft Excel Excel reports and Risk-Based Quality Management reports are 
available only if Microsoft Excel 2000, XP, or 2003 is installed 
on your machine. 

CPU Pentium III (or higher) or equivalent x86 compatible processor
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Citrix Configurations
To run Quality Center on Citrix, you need the following configurations. 

For more information on the Citrix configuration, refer to the Customer 
Support Knowledge Base (http://support.mercury.com/cgi-bin/portal/CSO/
kbBrowse.jsp), select TestDirector for Quality Center and search for Article 
Number 38333.

VMware ESX Configurations
Quality Center can be deployed on a VMware ESX 3.0.1 Server. The system 
configurations of each virtual machine are the same as the Quality Center 
server system configurations. For more information, see “Server System 
Configurations” on page 19. 

Citrix Server

Citrix Presentation Server 4, on: 

➤ Windows 2000 Server with Service Pack 4

➤ Windows Server 2003 Standard/Enterprise Edition

Citrix Client

Program Neighborhood, Version 8, on:

➤ Windows 2000 Server/Professional with Service 
Pack 4

➤ Windows XP Professional/Home Edition with 
Service Pack 2

Quality Center Server Supports all environments

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Installation Checklist

Review and verify the following checklist before installing Quality Center 
on your server machine. The checklist outlines the information that you 
must supply during the installation process. For more detailed information 
on the installation configurations, including permissions and privileges, see 
“Quality Center Server-Side Prerequisites” on page 26.

Check Information Required

Installation 
Machine

➤ Operating system version

➤ CPU type

➤ Free disk space

➤ Free memory

Where to get information? 

For the list of supported versions, see “System Configurations” 
on page 18.

License Key ➤ License file

➤ Maintenance key

Where to get information? 

The license file was sent to you by e-mail. The maintenance 
key appears on the box.

Cluster 
Description

➤ Is clustering used? 

➤ Cluster hosts

Application 
Server

➤ Server type (JBoss, WebLogic, or WebSphere)

➤ Server version

If you use JBoss:

➤ Port number

To run JBoss as a service on Windows machines:

➤ JBoss service user name

➤ JBoss service user password

➤ JBoss service user domain
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Web Server ➤ Server type (IIS or JBoss)

If you use IIS:

➤ IIS version

➤ Web site

Mail Server ➤ Server type

➤ Server host

Demo Project ➤ Is the demo project required?

Database 
Server

➤ Database type

➤ Database version

➤ Database server name

➤ Database administrator user name

➤ Database administrator user password

➤ Database port

If you use Oracle:

➤ Database SID

➤ Default tablespace

➤ Temp tablespace

Site 
Administration

➤ Site Administrator user name

➤ Site Administrator password

Existing 
Quality Center 
Installation

If there is an existing Site Administration schema, provide the 
following information for the existing version: 

➤ Quality Center version

➤ Quality Center host

➤ Will the schema be used in the new version?

➤ Database server name

➤ Database administrator user name

➤ Database administrator password

➤ Site Administration database schema name

➤ Site Administration database schema password

➤ Repository folder

Repository ➤ Repository folder

Check Information Required
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Quality Center Server-Side Prerequisites

The following prerequisites must be met before you can install 
Quality Center on your server machine.

For the Quality Center server installation checklist, see “Installation 
Checklist” on page 24.
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System Configurations
Verify that your server machine meets the Quality Center system 
configurations. For more information on system requirements and 
supported configurations for Quality Center, see “Server System 
Configurations” on page 19.

Permissions Required to Install Quality Center
Verify you have the required permissions to install Quality Center on a 
Windows, Solaris, Linux, or AIX server machine. 

Installing on Windows

To install on Windows, you must be logged on as a local or domain user 
with administrator permissions. The user name of the logged on user 
installing Quality Center must not include a pound sign ("#").

Note: If you are a local user and the repository is on a remote machine, you 
must have full read and write permissions on the shared repository 
directory.

You must have the following file system permissions:

➤ Full read and write permissions for all the files and directories under the 
directory in which Quality Center is installed. The installation directory 
path is specified by the user during installation. By default, Quality Center 
writes the installation files to C:\Program Files\Mercury\Quality Center.

➤ Full read and write permissions to the Repository directory which contains 
the Site Administration and Quality Center directories. The repository path 
is specified by the user during installation. By default, it is located in the 
Quality Center installation directory. For more information on the 
repository, refer to the HP Quality Center Administrator’s Guide.



Chapter 1 • Before You Install

28

➤ Full read and write permissions to the system root (%systemroot%) 
directory. The installer program writes the product information to the 
vpd.properties file in the system root directory. If you do not have these 
permissions, you can still install Quality Center, but you cannot install any 
patches. 

➤ Full read and write permissions to the Temp (%TEMP% or %TMP%) 
directory. The installer program writes installation and log files to this 
directory. Verify that you have at least 500 MB free space on this directory to 
perform the installation.

You must have the following registry key permission:

Full read and write permissions to all the keys under 
HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive

Installing on Solaris, Linux, or AIX

To install on Solaris, Linux, or AIX, you must have the following file system 
permissions:

➤ Full read and write permissions for all the files and directories under the 
directory in which Quality Center is installed. By default, the Quality Center 
installation files are written to /opt/Mercury/QualityCenter. If users do not 
have the required permissions on /opt, Quality Center can be installed in a 
different folder.

➤ Full read and write permissions to the Repository directory which contains 
the Site Administration and Quality Center directories. The repository path 
is specified by the user during installation. By default, it is located in the 
Quality Center installation directory. For more information on the 
repository, refer to the HP Quality Center Administrator’s Guide.

➤ Full read and write permissions to the user home directory (~). The installer 
program writes the product information (the vpd.properties file) and the 
installation log files to the user home directory, which is typically located at 
/home/<installer user name>. If you do not have these permissions, you can 
still install Quality Center, but you cannot later uninstall Quality Center or 
install any patches.



Chapter 1 • Before You Install

29

➤ Full read and write permissions to the Temp directory. The installer program 
writes the source files, JVM, and log files to a temporary directory. The 
location of this directory is usually /tmp/Mercury or /var/tmp/Mercury. 
Verify that you have at least 500 MB free space on this directory to perform 
the installation.

License File and Maintenance Key
Verify that you have the Quality Center license file and maintenance key.

➤ You need to specify the path to the license file. The license file was sent to 
you by e-mail and has a .license file extension by default. If you do not have 
a valid license file, you can submit a request for a Quality Center license key 
from the Customer Support Web site (http://support.mercury.com).

➤ The maintenance key was supplied to you with the product package when 
you purchased Quality Center. This field is not mandatory.

Clustering Configuration
Verify whether you are installing Quality Center on a single node or as a 
cluster (ask your system administrator). For more information on cluster 
nodes, see Chapter 2, “Installing Quality Center.”

If you are installing Quality Center on cluster nodes, verify which machine 
you should use as the first node to start the installation, and the number of 
machines you should use. This depends on the number of users and 
availability considerations. When installing Quality Center on additional 
nodes, you must install the same version of Quality Center on all nodes, and 
insert the same repository and database details that you used on the first 
node.

Application Server Information
Verify which application server to use. You can use JBoss, WebLogic or 
WebSphere. 

If you are using JBoss, Quality Center is deployed automatically when the 
installation process finishes. 
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If you are using a WebLogic or WebSphere application server, you must 
deploy Quality Center manually after you install Quality Center. For more 
information on manual deployment, see “Manually Deploying 
Quality Center on WebLogic” on page 83, and “Manually Deploying 
Quality Center on WebSphere” on page 87.

JBoss Application Server

If you are using a JBoss application server, you must verify the following 
issues:

➤ For JBoss on Windows, verify that the user account set to run JBoss as a 
service is the same as the user account that is used to install Quality Center. 
The user must have full administrator privileges on the Quality Center 
server machine, as described in “Permissions Required to Install 
Quality Center” on page 27.

➤ For JBoss on Solaris, Linux, or AIX, verify that the user has full control 
permissions to run JBoss, as described in “Permissions Required to Install 
Quality Center” on page 27.

➤ Verify that the JBoss application server heap memory size is sufficient (the 
default is up to 1024 MB). Note that the maximum JBoss heap value cannot 
exceed your maximum memory (RAM) size. You can change the JBoss 
memory heap size during installation from the JBoss Advanced Options 
dialog box. For information on changing the heap size after installation, see 
“Changing the JBoss Heap Memory Size and Port” on page 117.

➤ Verify that the default JBoss port (8080) is not reserved or already in use. You 
can change the JBoss port during installation from the JBoss Advanced 
Options dialog box. For information on changing the port after installation, 
see “Changing the JBoss Port Number” on page 121.

➤ If you are upgrading from a previous version of Quality Center on the same 
machine, verify that you have the same Windows user name, password, and 
domain that you previously used to enable JBoss to run as a service using 
your local network. If you are upgrading from a different machine, you can 
use any user, provided that the user has permissions on the shared 
repository.
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WebLogic/WebSphere Application Server

If you are using a WebLogic/WebSphere application server, you must verify 
the following issues:

➤ Verify that the user account that is used to install and run Quality Center 
has full permissions on the Quality Center installation directory.

➤ If upgrading from a previous version of Quality Center, verify that the user 
account that is used to install and run Quality Center has full permissions 
on the existing Quality Center repository directory.

Web Server Information
Verify and consider the following issues:

➤ If you are using a JBoss application server, you can integrate JBoss with the 
IIS Web server or with the JBoss Web server during installation.

➤ If you are using an application server other than JBoss, or JBoss with an 
Apache Web server, you must deploy the Web server after installation.

➤ If you are using an Apache Web server to integrate Quality Center with 
Apache, you can manually configure the Apache Web server to redirect 
requests to JBoss. The Quality Center installation DVD includes the 
appropriate Apache installation files and the integration files. For 
information on how to integrate Quality Center with Apache, see 
Chapter 5, “Manually Integrating JBoss with Apache.”

Quality Center Demo Project and Mercury Tours
Verify which additional Quality Center components you want to install:

➤ Quality Center Demo Project. This helps you get started with 
Quality Center. You must install the demo project to work with the 
Quality Center Tutorial.

➤ Mercury Tours. This is a sample Web-based travel reservation application 
that you must install to work with the Quality Center Tutorial.
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Mail Server Information
Verify which mail server to use. Ask your system administrator for 
assistance. If you are using an SMTP Server, check that you have the SMTP 
Server name. The installer checks that the specified mail server name is valid 
and that the mail server is running.

Database Prerequisites for Oracle
Verify that you have the following Oracle database information.

Database type and 
version

Verify that Quality Center supports your database type 
and version. For the list of supported databases, see 
“System Configurations” on page 18.

Database server 
name

Verify the name of the database server.

Database user 
permissions

Verify that you have the database permissions required to 
install Quality Center on the Oracle database server. For a 
list of required permissions, see “User Permissions for 
Installing Quality Center on an Oracle Database” on 
page 34.
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Database schema 
name and password

➤ The default Site Administration database schema name 
is qcsiteadmin_db. If you want to rename the schema, 
you can change the name in the Advanced Database 
Server Configuration dialog box. For more information, 
see step 22 on page 69.

➤ You can create your own Quality Center user password 
for accessing the database schema.

➤ If there is an existing database schema, verify whether 
you want to:

➤ Upgrade the existing schema and switch all users to 
Quality Center 9.2.

➤ Create a copy of the existing schema and upgrade 
the copy. This enables you to work with 
Quality Center 9.2 and previous versions of 
Quality Center simultaneously (recommended 
option).

➤ To install Quality Center on an existing database 
schema (second node or upgrade), you must have:

➤ The existing database schema name and the 
database administrator permissions required to 
install Quality Center on the database server.

➤ Full read/write permissions on the existing 
repository (see “Permissions Required to Install 
Quality Center” on page 27).

➤ If you are using an existing Site Administration user, 
the password should be the same as the one in the 
previous version of Quality Center (see 
“Quality Center Site Administration Login 
Credentials” on page 42).

➤ The Quality Center server must have access to the 
previous Site Administration schema repository 
path.

➤ The Quality Center user have full read/write 
permissions to the previous Site Administration 
schema repository path.
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User Permissions for Installing Quality Center on an Oracle 
Database

To install Quality Center on an Oracle database server, the installing 
database user must have sufficient permissions to perform certain 
administrative tasks in Oracle. These tasks include creating the 
Quality Center project user schema, copying data between projects, and 
checking that there is sufficient storage in a specific tablespace.

If you have the Oracle system user, you can use this user to install 
Quality Center. If you are unable to use the Oracle system user due to 
security reasons, it is recommended that your database administrator create 
a Quality Center database administrative user, for example qc_admin_db, 
with the specific privileges required to install Quality Center. 

Your database administrator can create a Quality Center database 
administrative user using the example script, qc_admin_db___oracle.sql, 
which is located in the \utilities\databases\scripts directory on the 
installation DVD. This script creates the Quality Center database 
administrative user with the recommended grants required on the database. 
Your database administrator should run the script and create this user on the 
staging database server.

Database tablespace 
name and size

➤ Verify the name of the database server, and check the 
connection to the database server. Ping the database 
server machine name to test DNS resolution.

➤ Verify you have the tablespace names (default and 
temporary) and the minimum tablespace sizes for 
storing the Quality Center schema. To avoid 
insufficient tablespace for installing Quality Center, it 
is recommended to have at least 60 MB of free space in 
the default storage location, and 30 MB of free space in 
the temporary storage location.

➤ Verify that the tablespace is not locked.
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Following are the recommended privileges required by the Quality Center 
database administrative user. Additional explanations about these privileges 
can be found in the notes at the end of the table.

Privilege Description

CREATE SESSION WITH 
ADMIN OPTION (1)

Quality Center uses this privilege to connect to the 
database as the Quality Center database 
administrative user.

CREATE USER Required to create a new project user schema when 
creating a new Quality Center project.

DROP USER When deleting a Quality Center project, 
Quality Center attempts to remove the database 
schema from the database server. If there is an 
insufficient privileges error, Quality Center ignores 
the error and requests that the user notify the 
database administrator to delete (drop) the database 
user schema.

CREATE TABLE WITH 
ADMIN OPTION (1)

Required for granting this permission to a newly 
created Quality Center project user schema.

CREATE VIEW WITH 
ADMIN OPTION (1)

Required to create views for Quality Center projects.

CREATE TRIGGER WITH 
ADMIN OPTION (1)

Required to create triggers for Quality Center 
projects. Quality Center uses database triggers to 
collect change history for specific tables.

CREATE SEQUENCE WITH 
ADMIN OPTION (1)

Required to create sequences for Quality Center 
projects.

CREATE PROCEDURE 
WITH ADMIN OPTION (1)

Required to create stored packages for Quality Center 
projects. Quality Center uses packages to collect 
change history for specific tables.

CTXAPP Role WITH 
ADMIN OPTION (1)

Enables Quality Center to use the Oracle text 
searching feature. This role exists only if the Oracle 
text search component was installed and enabled on 
the database server.
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SELECT ON 
DBA_FREE_SPACE (2)

Required to check free space on the database server 
prior to creating a new database schema for Site 
Administration or a new project.

SELECT ON 
SYS.DBA_TABLESPACES 
(2)

Required to collect a list of tablespaces that exist on 
the database server prior to creating a new database 
schema for Site Administration or a new project.

SELECT ON 
SYS.DBA_USERS (2)

Required to verify the existence of specific database 
project users. For example, you might want to verify 
the existence of an Oracle CTXSYS user before 
creating a new Quality Center project.

SELECT ON 
SYS.DBA_REGISTRY (2)

Required to verify that the text search component is 
installed on the database server.

SELECT ON 
SYS.DBA_ROLES (2)

Required to verify that the text search role (CTXAPP) 
is installed on the database server.

SELECT ANY TABLE WITH 
ADMIN OPTION (1)

Required for various administrative operations when 
upgrading the Site Administration schema during 
installation using the copy and upgrade method, and 
for enhancing performance when copying a project 
that has the same source and target database server.

INSERT ANY TABLE Required for various administrative operations when 
upgrading the Site Administration schema during 
installation using the copy and upgrade method, and 
for enhancing performance when copying a project 
that has the same source and target database server.

Notes:

➤ (1) A Quality Center database administrative user must have privileges with 
Admin Option.   

➤ (2) The SELECT ON SYS privileges can be given directly by the table owner, or 
through a database application role. To avoid giving these privileges each time, 
you can grant this role to the Quality Center database administrative user. The 
recommended name for this role is QC_SELECT_ON_SYS_OBJECTS. You can 
create this role using the qc_sys_db___oracle.sql example script, which is 
located in the \utilities\databases\scripts directory on the installation DVD. 
You should run this script before you run the qc_admin_db___oracle.sql script.

Privilege Description
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When creating a new project or restoring an existing one, Quality Center 
creates a project user schema. This user schema hosts all the tables that are 
used by the project for storing and retrieving data. Following are the 
required privileges for a Quality Center project user schema:

Tip: The installation DVD contains an example script that describes the 
recommended permissions required for the Quality Center database project 
user schema. This script contains information, and does not need to be run. 
It is located at \utilities\databases\scripts\qc_project_db___oracle.sql.

Project User Schema 
Privilege

Description

QUOTA UNLIMITED ON 
<default tablespace>

Required for creating database objects that are owned 
by the Quality Center project user schema. This 
requirement allows users to create tables in the default 
tablespace. It replaces the UNLIMITED TABLESPACE 
system privilege that gave users system privileges to 
create tables in any tablespace, including the SYSTEM 
tablespace.

CREATE SESSION Quality Center uses this privilege to connect to the 
database user schema to perform required operations, 
for example creating database objects such as tables, 
and using them to insert, retrieve, and delete data from 
them.

➤ CREATE TABLE

➤ CREATE VIEW

➤ CREATE TRIGGER

➤ CREATE SEQUENCE

➤ CREATE PROCEDURE

➤ CTXAPP Role

For a description of these privileges, see the table of 
required Quality Center database administrative user 
privileges on page 35.
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Database Prerequisites for Microsoft SQL
Verify that you have the following Microsoft SQL database information.

Database type and 
version

➤ Verify that Quality Center supports your database type 
and version. For the list of supported databases, see 
“System Configurations” on page 18.

➤ Verify the database server authentication type: 
Windows or SQL Server authentication.

➤ For Microsoft SQL Server Windows Authentication, 
check that you can log in to the database. If you 
upgrade a project to Quality Center 9.2, you must use 
the same type of SQL Server authentication that you 
used before the upgrade.

Database server 
name

Verify the name of the database server.
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Database user 
permissions

Verify that you have the database permissions required to 
install Quality Center on the SQL database server (not 
applicable for Microsoft SQL Server Windows 
Authentication). For a list of required permissions, see 
“User Permissions for Installing Quality Center on a 
Microsoft SQL Server” on page 40.

Database schema 
name and password

➤ The default Site Administration database schema name 
is qcsiteadmin_db. If you want to rename the schema, 
you can change the name in the Advanced Database 
Server Configuration dialog box. For more information, 
see step 22 on page 69.

➤ You can create your own Quality Center user password 
for accessing the database schema.

➤ If there is an existing database schema, verify whether 
you want to:

➤ Upgrade the existing schema and switch all users to 
Quality Center 9.2.

➤ Create a copy of the existing schema and upgrade 
the copy. This enables you to work with 
Quality Center 9.2 and previous versions of 
Quality Center simultaneously (recommended 
option).

➤ To install Quality Center on an existing database 
schema (second node or upgrade), you must have:

➤ The existing database schema name and the 
database administrator permissions required to 
install Quality Center on the database server.

➤ Full read and write permissions on the existing 
repository (see “Permissions Required to Install 
Quality Center” on page 27).

➤ If you are using an existing Site Administration user, 
the password should be the same as the one in the 
previous version of Quality Center (see 
“Quality Center Site Administration Login 
Credentials” on page 42).
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User Permissions for Installing Quality Center on a Microsoft 
SQL Server

To install Quality Center on a Microsoft SQL database server, the installing 
database user must have sufficient permissions to perform certain 
administrative tasks in SQL.

If you have the SQL sa user, you can use this user to install Quality Center. If 
you are unable to use the SQL sa user due to security reasons, it is 
recommended that your database administrator create a Quality Center 
database administrative user, for example qc_db_admin, with the specific 
privileges required to install Quality Center.

The Quality Center database administrative user must have the 
Database Creators role. You can also grant the user the Security 
Administrators role. This allows you to create a qc user with only those 
privileges required for running Quality Center. Alternatively, you can create 
a qc user before installing Quality Center. To create a qc user, follow steps 1-
3 below, and enter qc as the user name. It is important that the qc user does 
not have any server role.

To create a Quality Center database administrative user on Microsoft SQL 
Server 2000:

 1 Open the Enterprise Manager.

 2 Navigate to Console Root > Microsoft SQL Servers > SQL Server Group > 
<machinename> > Security > Logins.

 3 Right-click Logins, and select New Login.

 4 Enter qc_db_admin as the user name, and select the authentication type 
(enter password if necessary).

 5 Click the Server Roles tab, and select the Database Creators option.

 6 Click OK.
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To create a Quality Center database administrative user on Microsoft SQL 
Server 2005:

 1 Open the SQL Server Management Suite.

 2 Under Database Engine, right-click the machine name, and select Connect > 
Object Explorer.

 3 In the Object Explorer window, click Security, right-click Logins, and select 
New Login.

 4 Enter qc_db_admin as the user name, and select the authentication type 
(enter password if necessary).

 5 Click the Server Roles tab, and select the dbcreator option.

 6 Click OK.

To test the Quality Center database administrative user (SQL Server 
Authentication):

➤ To verify the select sysdatabases table permission in the master database:

SELECT name FROM sysdatabases where name=<db_name>

➤ To verify the create database permission:

CREATE DATABASE <dbName> -- the database name must not already exist

➤ To verify the drop database permission:

DROP DATABASE <database_name> -- the database name must exist

➤ To verify the select syslogins permission:

SELECT COUNT(*) FROM master..syslogins WHERE name=<dbOwnerName>

Note: The dbOwnerName must be set to td.
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To test the Quality Center database administrative user (Windows 
Authentication):

➤ To verify the change database context permission:

USE <dbName>

➤ To verify the create database permission:

CREATE DATABASE <dbName> -- the database name must not already exist

➤ To verify the select on syslogins permission:

SELECT COUNT(*) FROM master..syslogins WHERE name='<dbOwnerName>'

➤ To verify the select on sysusers permission:

SELECT COUNT(*) FROM master..sysusers WHERE name='<dbOwnerName>'

➤ To verify the grant all to td user permission:

GRANT ALL TO <dbOwnerName>

Quality Center Site Administration Login Credentials
You define the site administrator name and password when you log in to 
Quality Center Site Administration for the first time.

➤ For a clean installation, you can use any valid Quality Center Site 
Administration user name and password.

➤ For an existing database schema, if you are using an existing Site 
Administration user, the password should be the same as the one in the 
previous version of Quality Center. When upgrading from 
Quality Center 8.x, you can use any existing Quality Center 8.x user 
credentials (preferably a user that is an administrator). In addition, the 
project directory should point to your existing domain repository. 

Quality Center Repository Path
The location of the repository directory is specified by the user during 
installation. The default location is C:\Program Files\Mercury\
Quality Center\repository. You must have full control permissions on the 
Quality Center repository path as described in “Permissions Required to 
Install Quality Center” on page 27.
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Quality Center Client-Side Prerequisites

The following prerequisites must be met before you can download 
Quality Center to your client machine. 

System Configurations
Verify that your client machines meet the Quality Center system 
configurations. For more information on client system requirements for 
Quality Center, see “Client System Configurations” on page 21.

Permissions Required to Download Quality Center
To download Quality Center on a client machine, you must be logged on as 
a local or domain user with administrator privileges, and have the file 
system and registry permissions listed below. After you have installed 
Quality Center on a client machine, a user with minimum privileges (for 
example, Users group privileges) can start the Quality Center client.

You must have the following file system permissions:

➤ Full read and write permissions on C:\Program Files\Common Files\
Mercury Interactive. This is where the Quality Center ActiveX files and 
executables are stored.

➤ Full read and write permissions on C:\WINNT (or C:\Windows on 
Windows XP). This is where the mercury.ini file is stored.

➤ Full read and write permissions to the Temp (%TEMP% or %TMP%) 
directory. The installer program writes installation and log files to this 
directory. This is generally located at 
C:\Documents and Settings\<username>\Local Settings\Temp.
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You must have full read and write permissions on the following registry 
keys:

➤ HKEY_CLASSES_ROOT\AppID

➤ HKEY_CLASSES_ROOT\CLSID 

➤ HKEY_CLASSES_ROOT 

➤ HKEY_CLASSES_ROOT\Interface 

➤ HKEY_CLASSES_ROOT\TypeLib 

➤ HKEY_CURRENT_USER\Software 

➤ HKEY_LOCAL_MACHINE\SOFTWARE 

➤ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Cryptography\RNG

Internet Explorer Configuration
Before you download Quality Center on a client machine, you must 
configure the Custom Level security settings on the Web browser of the 
client machine. The Custom Level security setting should be configured for 
the specific zone of the Quality Center server.

To configure security settings on the client machine:

 1 In Internet Explorer, select Tools > Internet Options. The Internet Options 
dialog box opens.

 2 Click the Security tab. The Web content zone of the Quality Center server 
(Internet or Local intranet) is automatically selected. Click Custom Level.

 3 In the Security Settings dialog box, configure the following settings.

Under .NET Framework-reliant components:

➤ Set Run components not signed with Authenticode to Enable.

➤ Set Run components signed with Authenticode to Enable. 
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Under ActiveX controls and plug-ins:

➤ Set Run ActiveX controls and plug-ins to Enable.

➤ Set Download signed ActiveX controls to Enable or Prompt.

Note: You do not need to enable Download signed ActiveX controls if 
you install the Quality Center client by selecting Quality Center Client 
Side Setup in the HP Quality Center Add-ins page. For more information 
on installing add-ins, see Chapter 7, “Installing Quality Center Add-ins.”

 4 Click OK.

.NET Framework Installation
To install a Quality Center client, Microsoft .NET Framework 2.0 must be 
installed on the client machine. If it is not already installed, Quality Center 
prompts you to install it during the client installation. To perform the 
installation, follow the instructions in the Software Update Installation 
Wizard (if Windows Installer 3.1 is not installed) and the Microsoft .NET 
Framework 2.0 Setup.

The first time you run Quality Center, the user interface and configuration 
files for running Quality Center using Microsoft .NET framework are 
downloaded to C:\Program Files\Common Files\Mercury Interactive\
Quality Center\Client\Client.cab on the client machine. If 
.NET Framework 2.0 was not previously installed on the machine, 
dotnetfx.exe is also downloaded to C:\Program Files\Common Files\
Mercury Interactive\Quality Center.
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Working with Previously Created Projects

To work with projects created in TestDirector or previous versions of 
Quality Center, you must migrate or upgrade the projects. For more details, 
including guidelines for upgrading and migrating projects, refer to the 
HP Quality Center Administrator’s Guide.

If you are upgrading from Quality Center, and an existing Site 
Administration database schema exists on your database server machine, 
you must choose one of the following schema upgrade options during the 
installation process:

➤ Upgrade existing schema. Uses the existing Site Administration database 
schema. Choose this option if you want to upgrade the existing schema and 
switch all users to Quality Center 9.2. If you choose this option, you cannot 
work with projects or users created in previous versions of Quality Center 
until you upgrade them to Quality Center 9.2.

➤ Upgrade a copy of the existing schema. Creates a copy of the existing Site 
Administration database schema, and upgrades the copy. This is the 
recommended option as it enables you to work in Quality Center 9.2 with 
new and upgraded projects, and in your previous version of Quality Center 
with projects that have not been upgraded. This enables you to upgrade 
your existing projects incrementally. For further notes and guidelines on 
upgrading a copy of the existing schema, see “Guidelines for Upgrading a 
Copy of the Existing Schema” on page 47.

Note: The new database schema is created in the same tablespace as the 
existing Site Administration database.

For more information on using an existing database schema, see “Database 
Prerequisites for Oracle” on page 32, or “Database Prerequisites for Microsoft 
SQL” on page 38.
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Guidelines for Upgrading a Copy of the Existing Schema

If a Site Administration database schema exists on your database server 
machine and you choose to upgrade a copy of the existing schema, consider 
the following guidelines:

Project upgrade Before you upgrade a project to Quality Center 9.2, you must 
deactivate the project and remove it from the projects list in 
your previous version of Site Administration.

Quality Center 
users

After you install Quality Center 9.2, if you add or delete users, 
or update user details in your previous version of 
Quality Center, you must make the same changes in 
Quality Center 9.2.

Quality Center 
configuration 
parameters

After you install Quality Center 9.2, if you modify 
configuration parameters in your previous version of 
Quality Center, you must make the same changes in 
Quality Center 9.2.

Server node 
configuration

If you are working with server nodes, in the Servers tab in 
Site Administration for Quality Center 9.2, you must 
reconfigure the settings for the Quality Center server log file 
and the maximum number of database connections.

Quality Center 
repository path

The repository path in your previous version must be defined 
as a network path, so that it can be accessed by both the 
previous Quality Center server and by the Quality Center 9.2 
server.

DATACONST 
table

The following constants must be set as network paths in the 
DATACONST table: db_directory, tests_directory, 
unix_db_directory, and unix_tests_directory. This enables them 
to be accessed by both the previous Quality Center server and 
by the Quality Center 9.2 server.

Operating 
System

Quality Center 9.2 must be installed on the same operating 
system as your previous version of Quality Center.

Version control You must check in all tests before you upgrade a version 
control project. If version control is enabled in your previous 
version of Quality Center, you must also install the same 
version control add-in on the Quality Center 9.2 server.
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Text Search Configuration

Text search is available only if the text searching feature has been installed 
and configured on an Oracle or SQL database server. 

➤ For Microsoft SQL 2005 SP1 and Oracle 10g, the text search feature is 
installed by default, and no configuration is required.

➤ For Oracle 9i, you must install and configure the text searching feature on 
your Oracle database server. For more information on enabling the text 
search feature on the Oracle 9i database server and in Quality Center, refer 
to the HP Quality Center Administrator’s Guide.

➤ For Microsoft SQL 2000, Quality Center does not support the text search 
feature.
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2
Installing Quality Center 

This chapter describes how to install Quality Center 9.2 on Windows, Linux, 
Solaris, and AIX. It also describes how to run the Quality Center setup to 
install silently (in the background).

This chapter includes:

 ➤  About Installing Quality Center on page 49

 ➤  Mounting the File System Repository in a Clustered Environment on page 50

 ➤  Installing Quality Center on page 53

 ➤  Installing Quality Center in Silent Mode on page 79

About Installing Quality Center

You can install Quality Center on a single node or as a cluster. When you 
install Quality Center on cluster nodes, all nodes must be identical. For 
example, all nodes must use the same application server, operating system, 
Quality Center directory location, and Site Administration database. In 
addition, you must install the same version of Quality Center on all nodes.

If you are working in a clustered environment in Solaris, Linux, or AIX, you 
must mount the file system repository before you start the Quality Center 
installation process. For more information, see “Mounting the File System 
Repository in a Clustered Environment” on page 50.
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Note: When you are installing Quality Center on a secondary node of a 
cluster, you are not required to set up the database, because it was set up 
when you installed the primary node. Some of the dialog boxes described in 
this installation procedure are needed only for the primary node and are not 
displayed if you are installing a secondary node.

Mounting the File System Repository in a Clustered 
Environment 

When working in a clustered environment in Solaris, Linux, or AIX, you 
must mount the file system repository before you start the Quality Center 
installation process. The mount to the file system repository should not use 
any cache mechanisms. 

To mount a file system repository in Linux:

➤ NFS mounts: When using NFS mounts, modify the /etc/fstab file as follows:

➤ SMBFS mounts: When using SMBFS (mounted from a Windows machine), 
modify the /etc/fstab file as follows:

For example:

<source> <target> nfs sync,noac 0 0

<source> <target> smbfs
 credentials=/root/.smbpasswd,rw,gid=<GID>,uid=<UID>,
 fmask=0777,dmask=0777 0 0

//qcserver/QCrepository /mnt/QCrepository smbfs
credentials=/root/.smbpasswd,rw,gid=10,uid=qcadmin, 
fmask=0777,dmask=0777 0 0
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Where:

➤ //qcserver/QCrepository is the UNC of the source path

➤ uid=qcadmin is a domain user. Note that qcadmin must be a user on the 
Windows server, and must belong to the Administrators group.

➤ /mnt/QCrepository is the local folder

The qcadmin in this example must be defined in the credential file 
(/root/.smbpasswd) as follows:

You must also edit the /etc/samba/smb.conf file and change the workgroup 
value to a domain name (for example: MERCURY).

To mount a file system repository in Solaris:

NFS mounts: When using NFS mounts, modify the /etc/vfstab file as 
follows:

To mount a file system repository in AIX:

➤ SMB mount: When using SMB mounts, do the following:

If cifs is not installed, you will have to use smit install (with the installation 
DVD inserted) to install it.

➤ NFS mounts: When using NFS mounts, modify the /etc/fstab file as follows:

username = qcadmin
password = <qcadmin-password>

<source> - <target> nfs - yes sync,noac

mount -v cifs -n server/user/pass -o uid=<UID>,fmode=750 /<SHARE NAME> /mnt

mount <remote machine>:<remote path> <local path>
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For example:

#> mount venus:target /vol/vol1/a-m/apollo

* Pathname of mount point             [/target]                /
* Pathname of remote directory        [/vol/vol1/a-m/apollo]
* Host where remote directory resides [venus]
  Mount type name                     []
* Security method                     [sys] 
* Mount now, add entry to /etc/filesystems or both?   both
* /etc/filesystems entry will mount the directory     yes
* Mode for this NFS file system                       read-write
* Attempt mount in foreground or background           background
  Number of times to attempt mount                   []  
  Buffer size for read                               [4096] 
  Buffer size for writes                             [4096] 
  NFS timeout. In tenths of a second                 []
  NFS version for this NFS filesystem                 any 
  Transport protocol to use                           tcp 
  Internet port number for server                    []
* Allow execution of setuid and setgid programs       yes
* Allow device access via this mount?                 yes
* Server supports long device numbers?                yes
* Mount file system soft or hard                      hard
  Minimum time, in seconds, for holding              [3]
   attribute cache after file modification
  Allow keyboard interrupts on hard mounts?           yes
  Maximum time, in seconds, for holding              [60]
  Minimum time, in seconds, for holding              [30]
  Maximum time, in seconds, for holding              [60]
   attribute cache after directory modification
  Minimum & maximum time, in seconds, for            []
  The maximum number of biod daemons allowed         [6]
* Use acls on this mount?                            no
  Number of NFS retransmits                          []
* Exchange POSIX pathconf information?                no
* Inherit group IDs?                                  no
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This will mount /target from venus:/vol/vol1/a-m/apollo and add the 
following lines to the /etc/filesystem:

The mount point will be automatically mounted on reboot.

Installing Quality Center

This section describes how to install Quality Center 9.2.

Tips: 

➤ Before installing Quality Center, it is recommended that you verify that 
you meet the installation requirements in the “Quality Center Server-
Side Prerequisites” on page 26.

➤ If you encounter problems during the Quality Center installation 
process, see Appendix A, “Troubleshooting Quality Center Installation,” 
for troubleshooting suggestions.

To install Quality Center:

 1 If you are working in a clustered environment in Solaris, Linux, or AIX, 
mount the file system repository. For more information, see “Installing 
Quality Center in Silent Mode” on page 79.

 2 If you have been working with a previous version of Quality Center, back up 
your existing projects before installing the new version. For more 
information, refer to the HP Quality Center Administrator’s Guide.

/target:
        dev             = "/vol/vol1/a-m/apollo"
        vfs             = nfs
        nodename        = venus
        mount           = true
        options         = bg,hard,intr,rsize=4096,wsize=4096,proto=tcp,sec=sys
        account         = false
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 3 Log in to the Quality Center server machine with the appropriate 
permissions. For a list of required permissions, see “Permissions Required to 
Install Quality Center” on page 27.

 4 If Quality Center is installed on the machine, uninstall it. For more 
information, see Chapter 11, “Uninstalling Quality Center.”

Note: After you uninstall Quality Center, check that the 
<Quality Center home>\application directory was deleted. If it was not 
deleted, delete the directory before you install Quality Center again.

 5 Insert the HP Quality Center 9.2 Software installation DVD into the DVD 
drive and run the appropriate file.

 6 The Welcome dialog box opens. Click Next.

Platform To install:

Windows Run the setup.exe file.

Solaris, Linux, or AIX
(console mode)

➤ To install on a Solaris platform, type:
./setupSolaris.bin -console 

➤ To install on a Linux platform, type:
./setupLinux.bin -console 

➤ To install on an AIX platform, type:
./setupAix.bin -console 

Solaris, Linux, or AIX
(UI mode)

Make sure that the DISPLAY environment variable is 
properly configured on the Quality Center host machine, 
and that the machine from which you are installing is 
running an X-server (for example, Exceed). 

➤ To install on a Solaris platform, type:
./setupSolaris.bin

➤ To install on a Linux platform, type:
./setupLinux.bin

➤ To install on an AIX platform, type:
./setupAix.bin
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 7 The License Agreement dialog box opens.

Read the license agreement. To accept the terms of the license agreement, 
select I accept the terms of the license agreement. 

Click Next.

 8  The License Key dialog box opens.

License file. Select the Quality Center license file path.

Maintenance key. Type the maintenance number supplied to you when you 
purchased Quality Center.

For more information on the license file and maintenance key, see “License 
File and Maintenance Key” on page 29.

Click Next.
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 9 The Cluster Configuration dialog box opens.

Select a node configuration option:

➤ First node/Standalone. Installs Quality Center on the first node of a 
cluster or as a stand-alone application.

➤ Secondary node. If you have an existing node, installs Quality Center on 
another node to create a cluster.

For more information on cluster configuration, see “Clustering 
Configuration” on page 29.

Click Next.
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 10 The Directory Name dialog box opens.

Specify the location where you want to install Quality Center. To browse 
possible locations, click the Browse button, select a location, and click OK.

For more information on the required installation directory permissions, see 
“Permissions Required to Install Quality Center” on page 27.

Click Next.
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 11 The Application Server Configuration dialog box opens.

Select one of the following application server configuration options:

➤ JBoss Application Server. Select this option to work with JBoss.

To change the default JBoss port number or change the JBoss memory 
heap size, select Show advanced options for JBoss.

➤ Other Application Server. Select this option to work with WebLogic or 
WebSphere. 

For more information on the application server options, see “Application 
Server Information” on page 29.

Click Next.

 12 If you selected JBoss Application Server, proceed to step 13 on page 59.

If you selected Other Application Server, proceed to step 18 on page 64.
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 13 If you did not select Show advanced options for JBoss, proceed to step 14 on 
page 60. 

If you selected Show advanced options for JBoss, the JBoss Advanced 
Options dialog box opens.

In the Port number box, you can change the JBoss server HTTP port number. 
The default port is 8080.

Select the JBoss memory heap size to be used by the JBoss server. The default 
setting is up to 1024 MB. Note that the maximum JBoss heap value cannot 
exceed your maximum memory (RAM) size. For more information on JBoss 
performance tuning, refer to the JBoss documentation.

Click Next.

Note: You can update the heap memory value and port number on the JBoss 
application server after you have installed Quality Center. For details, see 
Chapter 10, “Changing the JBoss Heap Memory Size and Port.”
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 14 If you selected JBoss Application Server, the JBoss Service dialog box opens.

Type the User name, Password, and Domain to be used to run JBoss as a 
service. This enables the JBoss service to access your local network.

If you leave this blank, the local system account is used to run the JBoss 
service, and the JBoss service does not have access to your local network. 
This means that the repository and the database must be on the local 
machine.

For more information about user permissions, see “JBoss on Windows” on 
page 30.

Click Next.
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 15 If the IIS Web server is installed on your machine, proceed to step 16 on 
page 62.

If the IIS Web server is not installed on your machine, the following dialog 
box opens.

The Quality Center installer can integrate JBoss with the IIS Web server or 
with the JBoss Web server. Alternatively, you can manually integrate JBoss 
with the Apache Web server. For more information, see Chapter 5, 
“Manually Integrating JBoss with Apache.” By default, Quality Center 
integrates JBoss with the IIS Web server.

Choose one of the following options:

➤ To use JBoss as the Web server, click Next to continue the installation. 
Proceed to step 18 on page 64.

➤ To use IIS as the Web server, click Cancel to end the installation. Check 
that IIS is installed and running, then restart the installation.
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 16 If the IIS Web server is installed on your machine, the Web Server 
Configuration dialog box opens.

Select the Web server that you want to integrate with JBoss. For more 
information on the Web server options, see “Web Server Information” on 
page 31.

Note: For information on how to redirect requests to JBoss from an IIS server 
on a remote machine, refer to the Customer Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 37817.

Click Next.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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 17 If you selected JBoss Internal Web Server, proceed to step 18 on page 64.

If you selected IIS, the IIS Web Site dialog box opens.

Select the IIS Web site that you want Quality Center to use. It is 
recommended that you use the Default Web Site.

Click Next.
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 18 The HP Quality Center Components dialog box opens.

To help you get started with Quality Center, you can choose to install the 
Quality Center Demo Project. To work with the Quality Center Tutorial, you 
must install the Quality Center Demo Project and its accompanying sample 
Web-based travel reservation application.

Click Next. 
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 19 The Mail Server Properties dialog box opens.

To enable Quality Center to send e-mails to users in a Quality Center 
project, choose a mail protocol. For SMTP Server, type the server name. 

Click Next.

Note: To work with Microsoft IIS SMTP Service, perform the following steps:

➤ Open the Internet Information Services (IIS) Manager window.

➤ In the Tree pane, right-click Default SMTP Virtual Server and choose 
Properties. The Default SMTP Virtual Server Properties dialog box opens.

➤ In the Access tab, click the Connection button. The Connection dialog 
box opens. Choose All except the list below and click OK.

➤ Click the Relay button. The Relay Restrictions dialog box opens. Choose 
All except the list below and click OK.

➤ Click OK to close the Default SMTP Virtual Server Properties dialog box.
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 20 The Database Type Properties dialog box opens.

Select a database type for the Site Administration database schema.

If you select a Microsoft SQL Server, choose the authentication type:

➤ Microsoft SQL Server (SQL Server Authentication). Authenticates the 
user to the database using a database user name and password.

➤ Microsoft SQL Server (Windows Authentication). Windows 
authentication relies on the user being authenticated by the operating 
system.

For more information on database requirements, see “Database Prerequisites 
for Oracle” on page 32, and “Database Prerequisites for Microsoft SQL” on 
page 38.

Note: When upgrading a project to Quality Center 9.2, you must use the 
same type of SQL authentication that you used before the upgrade.

Click Next.
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 21 The Database Server Configuration dialog box opens.

Specify the following database connection information:

➤ Server name. Type the database server name. For example, dbsrv01.

➤ Database administrator user name. Type the name of the user with the 
administrative permissions required to install Quality Center on the 
database server. Not applicable for Microsoft SQL Server (Windows 
Authentication). 

➤ Database administrator password. Type the database administrator 
password. Not applicable for Microsoft SQL Server (Windows 
Authentication).

➤ Show advanced options. Select this option to define advanced options 
for your database type. These advanced options include the Site 
Administration database schema name and password, the database port, 
and the Oracle system identifier.
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For more information on database requirements, see “Database Prerequisites 
for Oracle” on page 32, and “Database Prerequisites for Microsoft SQL” on 
page 38.

Note: If you are installing Quality Center using a named instance of SQL 
Server, you must install Quality Center using a non-named instance and 
then change it afterwards. For more information on how to use a named 
instance of SQL Server with Quality Center, refer to the Customer Support 
Knowledge Base (http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), 
select TestDirector for Quality Center, and search for Article Number 41443. 

Click Next.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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 22 If you did not select Show advanced options, proceed to step 23 on 
page 70.

If you selected Show advanced options, the Advanced Database Server 
Configuration dialog box opens. 

Specify the following advanced database connection information:

➤ Site Administration database schema name. Type a Site Administration 
database schema name, or accept the default schema name.

Note: When upgrading an existing Site Administration database schema 
to work in Quality Center 9.2, you must use the same name that you 
used before the upgrade.

➤ Site Administration database schema password. Type the password for 
accessing the Site Administration database. This is a required field. Not 
applicable for Microsoft SQL Server (Windows Authentication). 

➤ Database server port. Type the database server port number, or accept 
the default port number.
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➤ Oracle SID. Type the Oracle system identifier. This is an Oracle parameter 
that identifies the specific Oracle instance on the host machine on which 
the Oracle server is installed. Not applicable for Microsoft SQL Server.

Click Next.

 23 For Oracle, if the Site Administration database does not exist, proceed to 
step 25 on page 72. 

For Microsoft SQL Server, if the Site Administration database does not exist, 
proceed to step 26 on page 74.

If the Site Administration database already exists, the Database Schema 
Found dialog box opens.
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Choose one of the following schema upgrade options:

➤ Upgrade existing schema. Uses the existing Site Administration database 
schema. Choose this option if you want to upgrade the existing schema 
and switch all users to Quality Center 9.2.

➤ Upgrade a copy of the existing schema. Creates a copy of the existing 
Site Administration database schema, and upgrades the copy. Choose this 
option to work in Quality Center 9.2 and previous versions of 
Quality Center simultaneously.

Important: Consider carefully before deciding which schema upgrade 
option to use. For more details on the schema upgrade options, and 
additional notes and guidelines, see “Working with Previously Created 
Projects” on page 46.

 Click Next.
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 24 If you selected Upgrade existing schema, proceed to step 26 on page 74.

If you selected Upgrade a copy of the existing schema, the Database Schema 
Found dialog box opens.

Choose a schema name under which to copy the existing Site 
Administration database. By default, Quality Center saves it with an 
incremental number suffix (for example, qcsiteadmin_db1).

Click Next, and proceed to step 26 on page 74.

 25 If you are installing Quality Center on a Microsoft SQL Server, proceed to 
step 26 on page 74.

If you are installing Quality Center on a second node, or if the Site 
Administration database already exists, the new database schema is created 
in the same tablespace as the existing schema. Proceed to step 26 on 
page 74.
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If you are installing Quality Center on Oracle, the Oracle Tablespaces dialog 
box opens.

Under Default Tablespace, select a default storage location from the list.

Under Temporary Tablespace, select a temporary storage location from the 
list.

Note: To avoid insufficient tablespace for installing Quality Center, it is 
recommended to have at least 60 MB of free space in the default storage 
location, and 30 MB of free space in the temporary storage location.

Click Next.
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 26 The Define HP Quality Center Site Administrator dialog box opens.

You use the site administrator name and password that you define in this 
dialog box to log in to Quality Center Site Administration for the first time. 
After installation, you can change the site administrator or add other site 
administrators from Site Administration.

Type a site administrator User name and Password, and retype the password 
to confirm.

Notes: 

➤ It is important that you remember the site administrator user name and 
password as otherwise you cannot log in to Site Administration.

➤ For an existing database schema, if you are using an existing user, the 
password should be the same as the one in the previous version of 
Quality Center. For more information, see “Quality Center Site 
Administration Login Credentials” on page 42.

Click Next.
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 27 The HP Quality Center Repository Path dialog box opens.

In the HP Quality Center repository path box, click the browse button to 
choose a repository path, or accept the default path. 

For more information on the Repository path, see “Quality Center 
Repository Path” on page 42.

Note: To work with cluster nodes, make sure that all nodes have access to 
this path.

Click Next.
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 28 The Installation Summary dialog box opens.

To review or change any settings, click Back.

To accept the settings and start the installation process, click Next. The 
installation process starts.
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 29 If your application server is other than JBoss, proceed to step 30.

If your application server is JBoss, the JBoss Launch dialog box opens.

Choose one of the following options:

➤ Yes. To start the JBoss server now.

➤ No. To manually start the JBoss server later.

Click Next. 

 30 When the installation process completes, the Installation Complete dialog 
box opens. Click Finish.

Note: If you are using JBoss, Quality Center is automatically deployed on 
your application server. If you are using another application server, you 
must deploy Quality Center manually. For more information on manually 
deploying Quality Center, see “Manually Deploying Quality Center on 
WebLogic” on page 83, and “Manually Deploying Quality Center on 
WebSphere” on page 87.
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 31 If you are prompted to restart your computer, you can choose to restart your 
computer at a later time, but you must restart your computer before you 
configure or use Quality Center. If you are prompted to restart, it is strongly 
recommended that you restart your computer as soon as possible. You must 
also restart your computer before you install any Quality Center related files, 
such as integration add-ins.

Note: To work with Quality Center, you might need to disable conflicting 
applications that are running on the Quality Center server machine. For a 
list of these applications, refer to the Customer Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 20022.

 32 You can use the Quality Center Checker to verify that the main 
Quality Center server components are successfully installed. You can also 
verify information such as directory paths, operating systems, permissions, 
resources, and port availability. For more information on the Quality Center 
Checker, refer to the HP Quality Center Administrator’s Guide.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Installing Quality Center in Silent Mode

You can install Quality Center using a silent installation. A silent 
installation runs the entire setup process in the background without 
requiring you to navigate through the setup screens and input your 
selections. Instead, all configuration parameters are allocated values you 
define in a response file. To run silent installations for different 
configurations, you can create multiple response files.

This section includes the following topics:

➤ Notes and Limitations

➤ Running a Silent Installation

Notes and Limitations
Before running a silent installation, consider the following issues:

➤ When running an installation in silent mode, no messages are displayed. 
Instead, you can view installation information in the log file, including 
information on whether the installation was successful. The installation log 
file can be found under the %tmp%\Mercury directory for Windows 
platforms. The log file can also be found under the home directory (~) of the 
user installing Quality Center for Solaris, Linux, and AIX platforms.

➤ The parameter -silent should appear only once, either in the response file or 
in the command line. If it appears in both the response file and the 
command line, the installation does not run. No error message displays.

➤ To troubleshoot installation issues, you can generate a log file for the 
launcher by adding the following command line to the launcher:
-is:log <path of output log>
For example:
-is:log c:\temp\launcher.log

This log file provides additional information not otherwise displayed, such 
as errors that may occur when launching the installation.
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Running a Silent Installation
You run a silent installation using a response file. You can create a response 
file using a response file template or by recording installation values during 
an installation.

To run a silent installation:

 1 Uninstall any previous installations of Quality Center from the server 
machine. 

 2 You can create a response file using a response file template or by recording 
installation values during an installation. 

➤ To create a response file template, and then modify it to meet your 
installation needs, run the command line:

➤ To create a response file by recording installation values during an 
installation, run the command line: 

Platform Command

Windows setup.exe –options-template <response file full path>

Solaris setupSolaris.bin –options-template <response file full path>

Linux setup_Linux.bin –options-template <response file full path>

AIX setup_AIX.bin –options-template <response file full path>

Platform Command

Windows setup.exe –options-record <response file full path>

Solaris setupSolaris.bin –options-record <response file full path>

Linux setup_Linux.bin –options-record <response file full path>

AIX setup_AIX.bin –options-record <response file full path>
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 3 To run a silent installation using a response file, run the command line:

Platform Command

Windows setup.exe –silent –options <response file full path>

Solaris setupSolaris.bin –silent –options <response file full path>

Linux setup_Linux.bin –silent –options <response file full path>

AIX setup_AIX.bin –silent –options <response file full path>
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3
Manually Deploying Quality Center on 
WebLogic

To work with Quality Center on a WebLogic application server, you must 
manually deploy Quality Center after installation. You also need to 
manually undeploy and redeploy Quality Center when installing patches or 
updating Quality Center files.

Notes: 

➤ For the latest updates on the information in this chapter, refer to the 
Customer Support Knowledge Base (http://support.mercury.com/cgi-
bin/portal/CSO/kbBrowse.jsp), select TestDirector for Quality Center, and 
search for Article Number 35712.

➤ You can change the WebLogic user name without having to reinstall 
Quality Center. For more information, refer to the Customer Support 
Knowledge Base (http://support.mercury.com/cgi-
bin/portal/CSO/kbBrowse.jsp), select TestDirector for Quality Center, and 
search for Article Number 42841.

This chapter includes: 

 ➤  Manually Deploying Quality Center on WebLogic on page 84

 ➤  Manually Undeploying Quality Center on WebLogic on page 85

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Manually Deploying Quality Center on WebLogic

You must manually deploy Quality Center on the WebLogic application 
server.

To manually deploy Quality Center on WebLogic:

 1 Navigate to the Quality Center home directory, and open the \application 
folder. By default, the home directory is C:\Program Files\Mercury\
Quality Center on Windows, and /opt/Mercury/QualityCenter on Solaris, 
Linux, and AIX.

 2 Copy the mtours.war, qcbin.war, and sabin.war files to the 
<WEBLOGIC_HOME>/server directory.

Note: The mtours.war file is only available if you installed Mercury Tours for 
the Quality Center Demo project. 

 3 Log in to the WebLogic Management Console and perform the following:

 a Navigate to MyServer > Deployments > Web Application Modules, and 
click the Configurations tab.

 b Click the Deploy a new Web Application Module link.

 c In the <WEBLOGIC_HOME>/server directory, select the sabin.war file, 
and start the WebLogic application server.

 d Click Target Module, and then click Deploy.

 e Repeat to deploy qcbin.war and mtours.war.

 4 When the deployment process completes, start Quality Center. For more 
information, see “Starting Quality Center.”
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Manually Undeploying Quality Center on WebLogic

If you install a patch or update the qcbin.war or sabin.war files, you need to 
undeploy and redeploy the war files for the changes to take effect in 
Quality Center.

To manually undeploy Quality Center on WebLogic:

 1 Log in to the WebLogic Management Console and perform the following:

 a Navigate to MyServer > Deployments > Web Application Modules, and 
click the Configurations tab.

 b Click the Delete button adjacent to qcbin.

 c Click Yes to confirm.

 d Click the Continue link.

 e Repeat to undeploy sabin and mtours.

 2 Delete the war files from <WEBLOGIC_HOME>/server.

Note: Do not delete the subdirectories under the \application directory. 
These subdirectories are required for third-party integration add-ins like 
Version Control.
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4
Manually Deploying Quality Center on 
WebSphere

To work with Quality Center on a WebSphere application server, you must 
manually deploy Quality Center after installation. You also need to 
manually undeploy and redeploy Quality Center when installing patches or 
updating Quality Center files.

Note: For the latest updates on the information in this chapter, refer to the 
Customer Support Knowledge Base (http://support.mercury.com/cgi-
bin/portal/CSO/kbBrowse.jsp), select TestDirector for Quality Center, and 
search for Article Number 38493.

This chapter includes: 

 ➤  Manually Deploying Quality Center on WebSphere on page 88

 ➤  Manually Undeploying Quality Center on WebSphere on page 90

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Manually Deploying Quality Center on WebSphere

You must manually deploy Quality Center on the WebSphere application 
server.

Note: You should verify the default maximum upload file size on the 
WebSphere application server. If the qcbin.war or sabin.war file size is larger 
than the default file size, you must increase the default maximum upload 
file size accordingly.

To manually deploy Quality Center on WebSphere:

 1 Start the WebSphere application server.

 2 Launch the WebSphere Administrative Console and perform the following 
steps to deploy the Quality Center sabin.war, qcbin.war, and mtours.war 
files: 

 a In the Administrative Console, choose Applications > Install New 
Application. 

 b Enter the local path of the sabin.war file, that was created during the 
installation of Quality Center. For example:

C:\Program Files\Mercury\Quality Center\application\sabin.war 

 c Enter sabin as the context root of the Web module, and click Next. 

 d On the subsequent screens, choose the default options, and click Next 
until you get to the last screen. Click Finish. 

 e After deployment has finished, click Save to Master Configuration, and 
then click Save.
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 f Repeat to deploy qcbin.war and mtours.war.

Notes: 

➤ It takes more time to deploy qcbin.war than sabin.war.

➤ The mtours.war file is only available if you installed Mercury Tours for 
the Quality Center Demo project. 

 3 Set the Web applications class loader policy for the sabin.war, qcbin.war, 
and mtours.war files: 

 a Choose Applications > Enterprise Applications > sabin_war. 

 b Click the Local Topology tab and choose sabin_war > Web Module > 
sabin.war. 

 c Set Classloader Mode to PARENT_LAST. Click OK. 

 d Click the Save link. 

 e Click the Save button.

 f Repeat for qcbin.war and mtours.war.

 4 Stop and restart the WebSphere application server.

 5 Start the deployed applications (Site Administrator and Quality Center) 
from Applications > Enterprise Applications.

 6 When the deployment process completes, start Quality Center. For more 
information, see “Starting Quality Center” on page 100.

Note: For information on how to install a Quality Center version control 
add-in on a WebSphere application server, refer to the Customer Support 
Knowledge Base (http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), 
select TestDirector for Quality Center, and search for Article Number 38951.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Manually Undeploying Quality Center on WebSphere

If you install a patch or update the qcbin.war or sabin.war files, you need to 
undeploy and redeploy the war files for the changes to take effect in 
Quality Center. 

To manually undeploy Quality Center on WebSphere:

 1 Start the WebSphere application server.

 2 Launch the WebSphere Administrative Console and perform the following 
steps to undeploy the war files: 

 a In the Administrative Console, choose Applications > Enterprise 
Application. 

 b Select sabin.war and qcbin.war and click Stop. 

 c Select sabin.war and qcbin.war and click Uninstall. 

Note: Do not delete the JBoss installation. JBoss deployment is required for 
third-party integration add-ins like Version Control.
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5
Manually Integrating JBoss with Apache

To use Quality Center with an Apache Web server, you need to manually 
configure the Apache Web server to redirect requests to the JBoss application 
server.

This chapter includes:

 ➤  About Manually Integrating JBoss with Apache on page 91

 ➤  Integrating JBoss with Apache on Windows on page 92

 ➤  Integrating JBoss with Apache on Solaris or Linux on page 93

 ➤  Apache-JBoss Integration Configuration Files on page 94

About Manually Integrating JBoss with Apache

When you install Quality Center, it does not automatically configure 
Apache to redirect requests to the JBoss application server. You must 
perform this configuration manually. The Quality Center installation DVD 
contains all the required files to enable you to configure the Apache-JBoss 
integration on Windows, Solaris, and Linux platforms.

All requests handled by the Apache Web server are redirected to a Tomcat 
server (which is a Servlet container delivered with JBoss). The 
communication between Apache and JBoss is implemented by using the 
AJP13 protocol, using an appropriate connector (called mod_jk).
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Integrating JBoss with Apache on Windows

You must manually integrate JBoss on the Apache Web server.

To integrate JBoss with Apache on Windows:

 1 Install Quality Center with JBoss as the application server and Web server.

 2 Install the Apache Web server. Quality Center supports Apache 2.0.54 
(which is also included on the installation DVD in the Apache Integration 
folder). To install from the DVD, run the apache_2.0.54-win32-x86.exe file, 
and follow the on-screen instructions.

 3 Navigate to <Apache Home directory>\conf, and unzip the 
apache_jboss_win32.zip file which is included on the installation DVD in 
the Apache Integration folder. This creates a new directory called 
qc_integration under the <Apache Home directory>\conf directory.

 4 Add the following lines to the httpd.conf file in the <Apache Home 
directory>\conf directory:

#Quality Center integration:This includes points to the Jboss-Apache 
#configuration file (for Quality Center)

#Load mod_jk module

LoadModule   jk_module conf\qc_integration\mod_jk.dll

Include conf\qc_integration\mod_jk.conf

 5 Restart the Apache Web server.

You can now connect to your Quality Center site using the following URL: 
http://<Quality_Center_server_name>/qcbin.

For more details regarding the Apache-Jboss integration configuration files, 
see “Apache-JBoss Integration Configuration Files” on page 94.
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Integrating JBoss with Apache on Solaris or Linux

You must manually integrate JBoss on the Apache Web server for Solaris or 
Linux.

To integrate JBoss with Apache on Solaris or Linux:

 1 Install Quality Center with JBoss as the application server and Web server.

 2 Install the Apache Web server. Quality Center supports Apache 2.0.54 
(which is also included in the Apache Integration folder on the installation 
DVD).

 3 Restart the Apache Web server.

You can now connect to your Quality Center site using the following URL: 
http://<Quality_Center_server_name>/qcbin.

For more details regarding the Apache-Jboss integration configuration files, 
see “Apache-JBoss Integration Configuration Files” below

Platform To install:

Solaris Uncompress apache_2.0.54_solaris.tar under the 
/opt/ directory (referred to here as <install dir>). 
This creates a new directory called apache2 under 
<install dir>.

Linux Uncompress apache_2.0.54_linux.tar under the 
/opt/ directory (referred to here as <install dir>). 
This creates a new directory called apache2 under 
<install dir>.
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Apache-JBoss Integration Configuration Files

The following files are related to the Apache-JBoss integration:

➤ In Windows, mod_jk.dll, and in Solaris or Linux, mod_jk_so. This file is the 
connector between the Apache Web server and the Tomcat component 
delivered with JBoss.

➤ httpd.conf. This file is the connector between the Apache Web server and 
the Tomcat component delivered with JBoss.

The following lines can be found at the end of the file:

On Windows:

On Solaris or Linux:

➤ workers.properties. This file defines a Tomcat instance that waits to execute 
requests on behalf of a Web server (in this case Apache).

The content of the file defines a worker (an instance of Tomcat) that handles 
Quality Center requests (in this case the worker name is jboss0_ajp13_qc.)

LoadModule   jk_module conf\qc_integration\mod_jk.dll
Include conf\qc_integration\mod_jk.conf

LoadModule    jk_module conf/qc_integration/mod_jk.so
Include conf/qc_integration/mod_jk.conf

# Defining a worker named jboss0_ajp13_qc and of type ajp13
# Note that the name and the type do not have to match.
worker.list=jboss0_ajp13_qc
worker.jboss0_ajp13_qc.port=8009
worker.jboss0_ajp13_qc.type=ajp13
worker.jboss0_ajp13_qc.host=localhost
worker.jboss0_ajp13_qc.lbfactor=50 
worker.jboss0_ajp13_qc.cachesize=10 
worker.jboss0_ajp13_qc.cache_timeout=600 
worker.jboss0_ajp13_qc.socket_keepalive=1 
worker.jboss0_ajp13_qc.socket_timeout=300
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➤ mod_jk.conf. This is a configuration file containing information describing 
which requests should be redirected from Apache to the Tomcat instance. It 
also contains the path to the workers.properties file and general 
configuration issues.

On Windows:

# Where to find workers.properties
# Update this path to match your conf directory location (put workers.properties 
next to httpd.conf)
JkWorkersFile conf\qc_integration\workers.properties
# Where to put jk logs
# Update this path to match your logs directory location (put mod_jk.log next to 
access_log)
JkLogFile     conf\qc_integration\log\mod_jk.log
# Set the jk log level [debug/error/info]
JkLogLevel  info
# Select the log format
JkLogStampFormat "[%a %b %d %H:%M:%S %Y] "
# JkOptions indicate to send SSL KEY SIZE, 
JkOptions     +ForwardKeySize +ForwardURICompat -ForwardDirectories
# JkRequestLogFormat set the request format 
JkRequestLogFormat     "%w %V %T"
# Send everything for context /examples to worker named worker1 (ajp13)
JkMount /memory jboss0_ajp13_qc
JkMount /memory/* jboss0_ajp13_qc
JkMount /jk jboss0_ajp13_qc
JkMount /jk/* jboss0_ajp13_qc
JkMount /sabin jboss0_ajp13_qc
JkMount /sabin/* jboss0_ajp13_qc
JkMount /qcbin jboss0_ajp13_qc
JkMount /qcbin/* jboss0_ajp13_qc
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➤ On Solaris or Linux:

# Where to find workers.properties
# Update this path to match your conf directory location (put workers.properties next 
to httpd.conf)
JkWorkersFile conf/qc_integration/workers.properties
# Where to put jk logs
# Update this path to match your logs directory location (put mod_jk.log next to 
access_log)
JkLogFile     conf/qc_integration/log/mod_jk.log
# Set the jk log level [debug/error/info]
JkLogLevel  info
# Select the log format
JkLogStampFormat "[%a %b %d %H:%M:%S %Y] "
# JkOptions indicate to send SSL KEY SIZE, 
JkOptions     +ForwardKeySize +ForwardURICompat -ForwardDirectories
# JkRequestLogFormat set the request format 
JkRequestLogFormat     "%w %V %T"
# Send everything for context /examples to worker named worker1 (ajp13)
JkMount /memory jboss0_ajp13_qc
JkMount /memory/* jboss0_ajp13_qc
JkMount /jk jboss0_ajp13_qc
JkMount /jk/* jboss0_ajp13_qc
JkMount /sabin jboss0_ajp13_qc
JkMount /sabin/* jboss0_ajp13_qc
JkMount /qcbin jboss0_ajp13_qc
JkMount /qcbin/* jboss0_ajp13_qc
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6
Getting Started

This chapter introduces Quality Center options and resources. It also 
explains how to start Quality Center.

This chapter includes:

 ➤  Browsing the Quality Center Program Folder on page 97

 ➤  Starting and Stopping Quality Center Services on page 98

 ➤  Starting Quality Center on page 100

Browsing the Quality Center Program Folder

In Windows, after the Quality Center setup process is complete, the 
following items are added to your HP Quality Center program folder 
(Start > Programs > HP Quality Center):

Option Description

HP Quality Center Opens the Quality Center application. For more 
information, refer to the HP Quality Center User’s Guide.

Mercury Tours Demo Opens a sample flight reservation Web application. 
This Web application is used as a basis for the 
Quality Center Tutorial. For more information, refer to 
the HP Quality Center Tutorial.

Note: This application is only available if you selected 
it during the Quality Center installation.

Readme Opens the Quality Center Readme, which provides the 
latest news and information about Quality Center.
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Note: If you are using an application server other than JBoss, only 
HP Quality Center, Mercury Tours Demo, and Quality Center Checker are 
available in the program folder.

Starting and Stopping Quality Center Services

This section describes how to start or stop Quality Center services from 
Windows, Linux, Solaris, and AIX.

To start or stop Quality Center services from Windows: 

In the system tray, right-click the Quality Center icon and choose Start 
Quality Center or Stop Quality Center.

Tip: If you are working with JBoss, you can also start and stop 
Quality Center from the Mercury Quality Center service in the Services 
manager. 

Documentation Library Opens an online help system that provides access to 
Quality Center guides and references that are available 
online, in PDF format, or both.

Quality Center Checker A diagnostic tool that tests many of the Quality Center 
server components used by Quality Center. Running 
the Quality Center Checker can pinpoint the cause of 
many server side problems associated with accessing 
Quality Center. For more information, refer to the 
HP Quality Center Administrator’s Guide.

Site Administration Opens the Site Administration application. For more 
information, refer to the HP Quality Center 
Administrator’s Guide.

Option Description
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To start or stop Quality Center services from Linux, Solaris, or AIX: 

➤ If you are working with JBoss, run the following commands:

➤ If you are working with WebLogic, run the following commands:

➤ If you are working with WebSphere, run the following commands:

To start: <QC installation directory>/jboss/bin/run.sh start

To stop: Use one of the following options:

➤ <QC installation directory>/jboss/bin/run.sh stop (or Ctrl-C in 
console)

➤ kill <jboss process ID>

To start: <WebLogic installation directory>/user_projects/domains/
<QC domain name>/startWeblogic.sh

To stop: Use one of the following options:

➤ <WebLogic installation directory>/user_projects/domains/
<QC domain name>/stopWeblogic.sh

➤ kill <weblogic process ID>

To start: <WebSphere installation 
directory>/WebSphere/AppServer/bin/startServer.sh 
<WebSphere server name>

To stop: <WebSphere installation 
directory>/WebSphere/AppServer/bin/stopServer.sh
<WebSphere server name>
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Starting Quality Center

You launch Quality Center on your workstation from your Web browser.

Note: Multiple instances of Quality Center using the same browser process 
are unsupported. To open another instance of Quality Center, you must 
launch a new browser process.

To start Quality Center:

 1 Open your Web browser and type your Quality Center URL
http://<Quality Center server name>[<:port number>]/qcbin.

The Quality Center Options window opens.
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The Quality Center Options window contains the following links:

 2 Click the Quality Center link. The first time you run Quality Center, the 
following files are downloaded to your computer:

Option Description

Quality Center Opens the Quality Center application. For more 
information, refer to the HP Quality Center User’s 
Guide.

Site Administration Opens the Site Administration application. For more 
information, refer to the HP Quality Center 
Administrator’s Guide.

Add-ins Page Opens the Quality Center Add-ins page. For more 
information, see “Installing Quality Center Add-ins” 
on page 105.

Readme Opens the Quality Center Readme, which provides 
the latest news and information about 
Quality Center.

File Name Description

American.adm & 
Roget.adt

Enables spell checking and thesaurus capabilities.

bp_exec_agent.exe Contains the Business Process Execution Agent.

bp_test.ocx Contains the Business Process Test Module.

BPTReports.cab Contains the files for creating Business Process 
reports in QuickTest Professional and WinRunner.

Client.cab Contains the user interface and configuration files 
for running Quality Center using Microsoft .NET 
framework.

comp_type.ini Enables the various types of tests included in the 
Business Components module.

dotnetfx.exe Installs Microsoft .NET Framework 2.0 (only 
downloaded if .NET Framework 2.0 is not already 
installed on your machine).
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Each time Quality Center is run, it carries out a version check. If it detects a 
newer version, it downloads the necessary files to your machine.

dsoframer.ocx Contains the Rich Content Editor.

ExtensibilityAPI.dll Contains the Quality Center client user interface 
Extensibility API.

Free_MSR_Player.exe Enables the Micro Player. 

MerResourceLogger.dll Enables a common view for log files.

OTAClient.dll Contains the Open Test Architecture API for 
Quality Center projects.

OTAXml.dll & 
OTaReport.dll

Enables reporting capabilities.

QCClientUI.ocx Contains the Quality Center user interface.

QCRasUI.ocx Contains the Excel Reports.

sr_exec_agnt.exe Contains the System Test Remote Agent.

SRunner.ocx Enables VAPI-XP.

TdComandProtocol.exe Enables the connection between the mail service 
and Quality Center.

TDTmplt.tcf The template for the Document Generator.

test_type.ini Enables the various types of tests included in the 
Test Plan module.

WebClient.dll Contains a gate for Quality Center client/server 
communication.

wexectrl.exe Enables automated test execution.

WindowsInstaller-
KB893803-v2-x86.exe

Installs a Windows software update that enables the 
installation of Microsoft .NET Framework (only 
downloaded if Windows Installer 3.1 is not already 
installed on your machine).

XGO.ocx Enables the Execution Flow tab in the Test Lab 
module.

File Name Description
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Note: Quality Center prompts you to install Microsoft .NET Framework 2.0 
if it is not already installed on your machine. To perform the installation, 
follow the instructions in the Software Update Installation Wizard (if 
Windows Installer 3.1 is not installed) and in the Microsoft .NET Framework 
2.0 Setup.

After the Quality Center version has been checked and files have been 
updated if necessary, the Quality Center Login window opens.



Chapter 6 • Getting Started

104

 3 In the Login Name box, type your user name.

 4 In the Password box, type the password.

 5 Select the Automatically log in to my last domain and project on this 
machine check box if you want Quality Center to automatically log in to the 
last project in which you were working.

 6 Click Authenticate. Quality Center verifies your user name and password 
and determines which domains and projects you can access. If you specified 
automatic login, Quality Center opens.

If authentication fails, check your user name and password are correct and 
try again.

 7 In the Domain list, select a domain. By default, the last domain in which 
you were working is displayed.

 8 In the Project list, select a project. By default, the last project in which you 
were working is displayed.

If the demonstration project was installed on the Quality Center server, you 
can select the QualityCenter_Demo project (make sure that you select 
DEFAULT in the Domain list). The project helps introduce you to 
Quality Center and includes sample requirements, tests, test sets, test runs, 
and defects. For more information, refer to the HP Quality Center Tutorial.

 9 Click Login. Quality Center opens and displays the module (Releases, 
Requirements, Test Plan, Test Lab, or Defects) in which you last worked 
during your previous session.
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7
Installing Quality Center Add-ins

Quality Center offers integrations with HP testing tools as well as 
third-party, synchronization, and version control tools. To integrate 
Quality Center with other tools, you may need to install appropriate add-ins 
from the Quality Center Add-ins page.

Note: If you are integrating Quality Center with another tool, you can verify 
that you are using a supported version. On the Add-ins page, click the More 
Quality Center Add-ins link, and choose the appropriate Quality Center 
integrations matrix.
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To install a Quality Center add-in:

 1 Click Add-ins Page in the Quality Center Options window or choose Help > 
Add-ins Page in the Quality Center main window. The Quality Center 
Add-ins page opens.

The following Quality Center add-ins are available:

➤ HP Quality Center Connectivity. Enables you to integrate Quality Center 
with other tools.

➤ HP Quality Center System Test Remote Agent. Enables you to run a 
system test on a machine. You can run a system test to retrieve a 
machine’s system information, view a captured desktop image of a test 
run on a machine, or restart a machine.

➤ HP Quality Center Client Side Setup. Enables you to install all 
Quality Center modules on a client machine, without downloading them 
through a browser. 

➤ More HP Quality Center Add-ins. Enables you to install additional add-
ins. This page is continuously updated by HP. The add-ins include 
integrations with HP tools and third-party tools.
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 2 Click an add-in link. A page with additional information about the add-in 
opens. If you click the More Quality Center Add-ins link, the More 
Quality Center Add-ins page opens, enabling you to select additional add-
ins.

 3 Click the add-in guide link (where applicable) for instructions on using the 
add-in.

 4 Click the Download Add-in link to download and install the add-in. Follow 
the instructions on your screen.
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8
Verifying the IIS Configuration

If you encounter a problem in the Internet Information Server (IIS) 
component after you install Quality Center on Windows, you should check 
the IIS configuration settings.

This chapter includes: 

 ➤  IIS Account Settings on page 109

 ➤  Quality Center Virtual Directory Settings on page 111

IIS Account Settings

The Quality Center installation creates the IUSR_<COMPUTER NAME> 
account. IIS uses this account to redirect users from IIS to Quality Center 
when they open Quality Center. 

To check the IIS account:

 1 Open the Internet Information Services Manager:

➤ If you have IIS 5.0, from the Start menu, choose Programs > 
Administrative Tools > Internet Services Manager. The Internet 
Information Services window opens.

➤ If you have IIS 6.0, from the Start menu, choose Programs > 
Administrative Tools > Internet Information Services (IIS) Manager. The 
Internet Information Services (IIS) Manager window opens.

 2 Expand the tree in the left pane, if needed, and select the directory in which 
your Quality Center virtual directory is located. This is the IIS Web site that 
was selected during the Quality Center installation (for example, Default 
Web Site). For more information, see Chapter 2, “Installing Quality Center.”
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 3 Right-click the Quality Center virtual directory (by default, quality_center) 
and choose Properties. The quality_center Properties dialog box opens.

 4 Click the Directory Security tab.

 5 In the Anonymous Access and Authentication Control section, click the Edit 
button. The Authentication Methods dialog box opens.

The Authentication Methods dialog box contains three methods for setting 
up the user account used by IIS to authenticate user access: anonymous 
access, basic authentication, and integrated Windows authentication. 

➤ Anonymous Access Authentication.

If Anonymous access is selected, when a user logs on to <Quality Center 
server>/qcbin or <Quality Center server>/sabin, IIS redirects the 
connection from IIS to Quality Center. 

To check or change this account, click the Anonymous Access Edit 
button. The user account for IIS anonymous access is IUSR_<COMPUTER 
NAME>.
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➤ Basic Authentication.

If Basic authentication is selected, when a user logs on to <Quality Center 
server>/qcbin or <Quality Center server>/sabin, IIS authenticates the user 
according to the Windows domain. 

To check the Windows domain for basic authentication, select the Basic 
authentication check box and click Yes to confirm. Then, click the Basic 
Authentication Edit button. The Basic Authentication Domain dialog box 
opens. If a domain is defined in the Domain Name box, the client can 
access IIS with any user account from that domain. If no domain is 
defined, the local domain is used, and the client can access IIS with any 
local user account.

When basic authentication is selected, the Web browser transmits user 
accounts across the network in an unencrypted form.

➤ Integrated Windows Authentication.

The Integrated Windows Authentication method is best suited for an 
intranet environment. IIS uses the current Windows user information on 
the client machine to authenticate the user according to the Windows 
domain. 

Quality Center Virtual Directory Settings

Verify that the default virtual directory (by default, quality_center) is 
configured properly. 

To check the configuration for the Quality Center virtual folders:

 1 Open the Internet Information Services Manager:

➤ If you have IIS 5.0, from the Start menu, choose Programs > 
Administrative Tools > Internet Services Manager. The Internet 
Information Services window opens.

➤ If you have IIS 6.0, from the Start menu, choose Programs > 
Administrative Tools > Internet Information Services (IIS) Manager. The 
Internet Information Services (IIS) Manager window opens.
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 2 Expand the tree in the left pane, if needed, and select the directory in which 
your Quality Center virtual directory is located. This is the IIS Web site that 
was selected during the Quality Center installation (for example, Default 
Web Site). For more information, see Chapter 2, “Installing Quality Center.”

 3 Right-click the Quality Center virtual directory (by default, quality_center) 
and choose Properties. The quality_center Properties dialog box opens. In 
the Virtual Directory tab, verify that the following options are set:

 4 Click OK to close the quality_center Properties dialog box.

Settings for IIS 5.0: Settings for IIS 6.0:

➤ Read is selected.

➤ Script source access, Write, and 
Directory browsing are cleared.

➤ The Application name box is 
enabled and the Remove button is 
visible.

➤ Scripts and Executables is selected in 
the Execute Permissions list.

➤ Medium (Pooled) is selected in the 
Application Protection list.

➤ Read is selected.

➤ Script source access, Write, and 
Directory browsing are cleared.

➤ The Application name box is 
enabled and the Remove button is 
visible.

➤ Scripts and Executables is selected in 
the Execute Permissions list.

➤ DefaultAppPool is selected in the 
Application Protection list.
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9
Customizing Quality Center

You can customize the names of the Quality Center modules, and the Tools 
and Help menus, by modifying the QCClient.UI.Ax.dll.config file on your 
Quality Center server machine.

To customize Quality Center:

 1 On your server machine, extract the QCClient.UI.Ax.dll.config file from 
Client.cab. This file is located:

➤ JBoss: In the [Install Dir]\[Server]\server\default\deploy\20qcbin.war 
file, (after extracting the war file, the Client.cab file is located under the 
\Install directory). 

➤ Other deployments: Initially in the application directory. From this 
directory, you can move the file to an alternative location.

 2 Open the QCClient.UI.Ax.dll.config file (this is in .xml format).

 3 To delete Quality Center modules or rearrange their order, locate the 
<Modules> section of the file, and delete or move the selected module 
section as required.

Note: To customize a module name, add the REPLACE_TITLE parameter in the 
Site Configuration tab in Site Administration. For more information, refer to 
the HP Quality Center Administrator’s Guide.
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 4 You can change the default names listed in the Tools menu in the Tools 
section of the file.

The following is the syntax of an entry in the Tools line:

<TDFrame
      Tools="<Tool_Name>,{<Tool_ID>}"
      Workflow="{<Workflow_ID>}"
      Parameters="<parameters>"
 />

 5 To change, delete, or rearrange the list of items in the Help menu, change 
the default names, IDs, and URLs listed in the OnlineHelpItem line. The 
following is the syntax of an entry in the OnlineHelpItem line:

<OnlineHelpItem 
ID="<Help_ID>" 
Name="<Help_Name>" 
Url="<Help_URL>" 

To create a separator line between two items in the Help menu, use the 
following syntax:

<OnlineHelpItem 
ID="<Help_ID>" 
Name="<Help_Name>" 
Url="<Help_URL>" 
IsFirstInGroup="true" />

Note: The first two menu items in the Help menu, Help on this page and 
Documentation Library, and the last Help menu item, 
About HP Quality Center, cannot be moved or changed. They do not have 
corresponding entries in the QCClient.UI.Ax.dll.config file. The above step 
only affects the menu items between them.

 6 Unzip the Client.cab file to a temporary folder named Client which must be 
under the temp folder. For example, C:\temp\Client.

 7 Replace the QCClient.UI.Ax.dll.config file with the modified file.



Chapter 9 • Customizing Quality Center

115

 8 Store the temporary folder on a logical drive, for example X, by running the 
following command:

subst [X]: <temp folder>

For example, subst X: C:\temp

 9 Create a new Client.cab file with the command:

cabarc -r -p -P Client\ -s 6144 N <temp folder>\Client.cab X:\Client\*.*

Note: To use this command you must first download cabsdk.exe (the 
Cabinet Software Development Kit) from the Microsoft Download Center.

 10 Add a class 3 digital signature to the new Client.cab file.

Important: The digital signature must be a signature of a trusted provider.

 11 Replace the old cab file with the new file.

 12 Rebuild the war file.

 13 Redeploy the war file. During the redeployment you cannot use 
Quality Center.
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10
Changing the JBoss Heap Memory Size 
and Port

After installing Quality Center, you can update the heap memory value on 
the JBoss application server if there is a change in the number of active 
projects or concurrent user sessions in Quality Center. You can also change 
the JBoss default port number.

This chapter includes: 

 ➤  Changing the JBoss Heap Memory Size on page 118

 ➤  Changing the JBoss Port Number on page 121

Note: For the latest updates on the information in this chapter, refer to the 
Customer Support Knowledge Base (http://support.mercury.com/cgi-
bin/portal/CSO/kbBrowse.jsp), and select TestDirector for Quality Center. 
Search for Article Number 41914 for changing the JBoss heap size, and 
37006 for changing the JBoss port number.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Changing the JBoss Heap Memory Size

If you select JBoss as the application server during the Quality Center 
installation, you can specify the memory heap value that is used by the 
JBoss server, or accept the default value (512-1024 MB). For information on 
how to specify the JBoss heap size during Quality Center installation, see 
“Mounting the File System Repository in a Clustered Environment” on 
page 50.

After you install Quality Center, you may need to change the JBoss heap 
memory values. For example, you may want to increase the JBoss heap size 
if there is an increase in the number of active projects in Quality Center, or 
an increase in the number of concurrent user sessions.

Note: The maximum JBoss heap value cannot exceed your maximum 
memory (RAM) size.

This section includes the following topics:

➤ Changing the JBoss Heap Size on Windows

➤ Changing the JBoss Heap Size on Solaris, Linux, and AIX

Changing the JBoss Heap Size on Windows
You can change the JBoss heap memory size on Windows server machines 
by uninstalling the Quality Center service, modifying the heap size in the 
InstallJbossService.bat file, and reinstalling the Quality Center service. You 
also need to modify the run.bat file to make sure that it is synchronized 
with the service.

To change the JBoss heap memory size on Windows:

 1 Verify that all users have logged out from Quality Center projects, and stop 
the Quality Center Service.

 2 Open Command Prompt, and navigate to the 
<QC_Installation_Path>\jboss\bin folder. By default, the Quality Center 
installation path is [drive]:\Program Files\Mercury\Quality Center.
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 3 To uninstall the existing service, run the following command:

 InstallJbossService.bat -uninstall

 4 To change the heap size, perform the following:

 a Open the InstallJbossService.bat file, and modify the heap size parameter 
as required. For example, if the heap memory is currently from 128 MB - 
512 MB: 

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m

you can increase the heap size from 128 MB - 1024 MB as follows:

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx1024m

 b Save and close the InstallJbossService.bat file.

 5 To reinstall the service with the modified heap size parameter, perform the 
following:

 a Run the following command:

InstallJbossService.bat -install

 b From the Start menu, choose Settings > Control Panel > Administrative 
Tools > Services, and verify that the service has been installed.

 c Start the Mercury Quality Center service.

 d Check that the specified heap size is shown as total memory. Open your 
Web browser, and type the following URL:

➤ For Quality Center: http://<Quality Center server name>:<port number>
/qcbin/servlet/tdservlet?method=debuginfo

➤ For Site Administration: http://<Quality Center server name>:<port 
number>/sabin/servlet/tdsiteadminservlet?method=debuginfo

Note: If you are working with cluster nodes, the Quality Center server 
name should be the node machine name, and you must perform the 
above steps on each node. 
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 6 To modify the run.bat file, perform the following:

 a Navigate to the <QC_Installation_Path>\jboss\bin folder.

 b In the run.bat file, change the heap size so that it is synchronized with 
the heap size changes you made in the InstallJbossService.bat file.

 c Save and close the run.bat file.

Changing the JBoss Heap Size on Solaris, Linux, and AIX
You can change the JBoss heap memory size on Solaris, Linux, and AIX 
server machines by modifying the run.sh file.

To change the JBoss heap memory size on Solaris, Linux, and AIX:

 1 Navigate to the $JBOSS_HOME/bin directory.

 2 To change the heap size, perform the following:

 a Open the run.sh file, and modify the heap size parameter as required. For 
example, if the heap memory is currently from 128 MB - 512 MB: 

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m

you can increase the heap size from 128 MB - 1024 MB as follows:

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx1024m

 b Save and close the run.sh file.

 3 Verify that all users have logged out from Quality Center projects, and 
restart the Quality Center service by running:

 a run.sh -stop.

 b run ps –ef | grep java (to make sure that the JBoss server has stopped)

 c run.sh -start

 4 Check that the specified heap size is shown as total memory. Open your 
Web browser, and type the following URL:

➤ For Quality Center: http://<Quality Center server name>:<port number>
/qcbin/servlet/tdservlet?method=debuginfo

➤ For Site Administration: http://<Quality Center server name>:<port 
number>/sabin/servlet/tdsiteadminservlet?method=debuginfo
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Note: If you are working with cluster nodes, the Quality Center server name 
should be the node machine name, and you must perform the above steps 
on each node.

Changing the JBoss Port Number

After you install Quality Center, you may need to change the port number 
on the JBoss application server if the port has been reserved or is already in 
use. The default port is 8080. You can change the port by updating the port 
number in the server.xml, mercury.xml, and siteadmin.xml files.

If you are using JBoss as your application server and as your Web server, the 
port number is shared, so you only need to change the port number on the 
application server. If the IIS Web server is installed on your machine, you 
must also change the port number on the IIS Web server.

To change the port number on the JBoss application server:

 1 Change the port number in the server.xml file.

 a Navigate to 
<QC_Installation_Path>\jboss\server\default\deploy\jbossweb-
tomcat50.sar, and open the server.xml file in a text editor. 

 b Change the port number. For example, if Connector port="8080", you can 
change it to Connector port="8081".

 2 Navigate to <QC_Installation_Path>\application, and back up the sabin.war 
and qcbin.war files.

 3 Change the port number in the mercury.xml file.

 a Create a temporary directory, qcbin, and extract the contents of 
qcbin.war into this directory. For example:

cd <QC_Installation_Path>\application\qcbin

jar xf "<QC_Installation_Path>\application\qcbin.war"
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Note: If the jar command is not defined, make sure to add the Java 
Virtual Machine path to the system environment variable Path. The 
default path is <QC_Installation_Path>\_jvm\bin. 

 b Navigate to <QC_Installation_Path>\application\qcbin\WEB-INF, and 
open the mercury.xml file in a text editor.

 c Change the port number. For example:

<URL>http://localhost:8081/sabin/servlet/tdsiteadminservlet</URL>

 d Zip the qcbin.war file. For example:

cd <QC_Installation_Path>\application\qcbin

jar cvf qcbin.war *

This should overwrite the existing qcbin.war file. 

 4 Change the port number in the siteadmin.xml file.

 a Create a temp directory, sabin, and extract the contents of sabin.war into 
this directory. For example:

cd <QC_Installation_Path>\application\sabin

jar xf "<QC_Installation_Path>\application\sabin.war"

 b Navigate to <QC_Installation_Path>\application\sabin\WEB-INF, and 
open the siteadmin.xml file in a text editor.

 c Change the port number. For example:

<URL>http://localhost:8081/qcbin/servlet/tdservlet</URL>

 d Zip the sabin.war file. For example:

cd <QC_Installation_Path>\application\sabin

jar cvf sabin.war * 

This should overwrite the existing sabin.war file.
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 5 Stop the JBoss application server. For more information on stopping and 
starting JBoss, see “Starting and Stopping Quality Center Services” on 
page 98.

 6 Copy the sabin.war and qcbin.war files to the 
<QC_Installation_Path>\jboss\server\default\deploy directory. 

 7 Rename sabin.war to 10sabin.war, and qcbin.war to 20qcbin.war. 

 8 Restart JBoss.

 9 Log in to Quality Center using the new port number.

To change the port number on the IIS Web server:

 1 Open the Internet Information Services Manager:

➤ If you have IIS 5.0, from the Start menu, choose Programs > 
Administrative Tools > Internet Services Manager. The Internet 
Information Services window opens.

➤ If you have IIS 6.0, from the Start menu, choose Programs > 
Administrative Tools > Internet Information Services (IIS) Manager. The 
Internet Information Services (IIS) Manager window opens.

 2 Expand the tree in the left pane, and stop the default Web site by right-
clicking Default Web Site, and selecting Stop. The service is marked 
(Stopped).

 3 Right-click Default Web Site and select Properties.

 4 Click the Web Site tab, change the port number in the TCP Port box, and 
click OK.

 5 To restart the default Web site, right-click Default Web Site, and select Start.

 6 When you open Quality Center, type the new port number in your 
Quality Center URL
http://<Quality Center server name>:<port number>/qcbin.

For example, if you changed the port from 8080 to 8081 on server Lab1, type
http://Lab1:8081/qcbin
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11
Uninstalling Quality Center

You can uninstall Quality Center from your server machine. When 
uninstalling Quality Center, projects are not deleted. You can also uninstall 
Quality Center components from a workstation that has been used to access 
Quality Center.

This chapter includes:

 ➤  Uninstalling Quality Center from Windows on page 125

 ➤  Uninstalling Quality Center from Linux, Solaris, or AIX on page 126

 ➤  Uninstalling Quality Center Components from a Workstation on page 126

Uninstalling Quality Center from Windows

This section describes how to uninstall Quality Center from your Windows 
server machine. 

To uninstall Quality Center from Windows:

 1 Make sure that the application server is running.

 2 To open the HP Quality Center Uninstall Wizard, you can:

➤ Choose Start > Settings > Control Panel > Add/Remove Programs, select 
HP Quality Center, and click the Change/Remove button. Follow the 
instructions on your screen.

➤ Locate the Quality Center home directory ([drive]:\Mercury 
Interactive\Quality Center). In the _uninst subdirectory, double-click 
uninstall.exe.

 3 Click Next. Follow the instructions on your screen.
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Uninstalling Quality Center from Linux, Solaris, or AIX

This section describes how to uninstall Quality Center from your Linux, 
Solaris, or AIX server machine.

Note: To uninstall Quality Center, you should use the same user that 
installed Quality Center.

To uninstall Quality Center from Linux, Solaris, or AIX:

 1 Make sure that the application server is running.

 2 Type the following command at the system prompt:

/[directory]/[Quality_Center_directory]/_uninst/uninstall.bin

The HP Quality Center Uninstall wizard opens.

 3 Click Next. Follow the instructions on your screen.

Uninstalling Quality Center Components from a 
Workstation

When you run Quality Center on your client computer, client components 
are downloaded to your workstation. You can use the client uninstall utility 
to remove all Quality Center client components, including files and registry 
keys. To download the utility, refer to the Customer Support Knowledge 
Base (http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 19734. 

If the workstation is used to access Quality Center after the utility has been 
run, all necessary components are downloaded from the Quality Center 
server. 

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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A
Troubleshooting Quality Center 
Installation

This chapter contains troubleshooting suggestions for issues relating to the 
Quality Center installation.

This chapter includes:

 ➤  Disabling Validation Checks on page 127

 ➤  Checking the Installation Log Files on page 129

 ➤  Quality Center Installation Already Exists on page 129

 ➤  Database Validator Fails on page 130

 ➤  IIS Site Not Responding on page 131

 ➤  JBoss Does Not Start on page 132

 ➤  Parameters of a Previous Installation are Used on page 134

Disabling Validation Checks

During installation, the Quality Center installer automatically performs 
validation checks to verify that particular installation requirements are met. 
If validation fails, you can disable checks in the installer by adding 
arguments to the installer command. You should disable validation checks 
only if you are sure that the validation result is wrong.

For example, you can disable the installation location validator that checks 
that the installation folder is accessible and that the user has read and write 
permissions to it. Type setup.exe -W installLocationValidator.active=false.
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You can disable the following installation validators:

Validator Checks To disable

Existing 
installation

Checks whether a Quality Center 
installation already exists on the 
server. For troubleshooting tips, 
see “Quality Center Installation 
Already Exists” on page 129.

-W handleExistingInstallation
Sequence.active=false

Operating 
system and 
license

Checks that the operating system 
is supported with the given 
license.

-W licenseAndOSValidator
Sequence.active=false

Mail server Checks that the mail server name 
is valid.

-W mailServerValidator.
acive=false

Database 
parameters

Checks the database version and 
system user permissions. For 
troubleshooting tips, see “Database 
Validator Fails” on page 130.

-W dbValidatorSequence.
active=false

Database 
existence

Checks that the TD user owns the 
existing database schema tables.

-W dbExistsValidator.active
=false

Repository 
folder

Checks that the repository folder is 
accessible, and the user has read 
and write permissions to it.

-W repositoryValidator.active
=false

Installation 
location

Checks that the installation folder 
is accessible, and the user has read 
and write permissions to it.

-W installLocationValidator.
active=false
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Checking the Installation Log Files

If you encounter problems installing Quality Center, check for errors in the 
following log files:

Quality Center Installation Already Exists

If during installation, an error message displays that a Quality Center 
installation already exists, you should verify that Quality Center is not 
installed, and that there are no traces of an old installation.

To verify that Quality Center is not installed:

 1 From the Start menu, choose Settings > Control Panel > Add/Remove 
Programs.

 2 In the program list, check for Mercury Quality Center or HP Quality Center.

 3 If either appears in the program list, click Remove, and follow the 
instructions on your screen.

 4 After you uninstall Quality Center, check that the 
<Quality Center home>\application directory was deleted. If it was not 
deleted, delete the directory before you install Quality Center.

Log Path

InstallShield log %TEMP%\Mercury\HP_Quality_Center.
<log_creation_date>.install.html

InstallShield 
second log

%TEMP%\Mercury\HP_Quality_Center.
<log_creation_date>.install.is.log

Schema creation 
logs

<Quality Center installation folder>\log\sa

Schema creation 
second log

<Quality Center installation folder>\InstallInfo\log

JBoss server log <Quality Center installation folder>\jboss\server
\default\log\process.log
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To remove traces of an old Quality Center installation:

 1 Navigate to the system root (%systemroot%) directory (on Linux, Solaris, or 
AIX, go to the /home directory).

 2 Make a backup of the vpd.properties file.

 3 In a text editor, open the vpd.properties file and delete any lines that 
mention Quality Center.

Database Validator Fails

During Quality Center installation, if the database validator fails, perform 
the following checks:

➤ Check that the input parameters are incorrect.

➤ Check that the Site Administration schema name was provided.

➤ If upgrading a Microsoft SQL Server site schema, check whether a different 
authentication type was used to the one used in the previous installation.

To check whether the parameters are correct:

 1 Read the error message that displays during installation, and try to 
understand and resolve the problem from the root cause.

 2 If you cannot understand the problem from the message, check with your 
database administrator.

 3 If no error was found and you are sure that the parameters are correct, 
disable the DB parameters validator as described in “Disabling Validation 
Checks” on page 127.

To check that the Site Administration schema name was provided:

 1 Open a database query tool.

 2 Make sure the PROJECTS table exists in the schema. This table exists in the 
Site Administration schema only and not in the project schema.
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To check the SQL authentication type of a previous installation (when 
upgrading an SQL Server site schema):

 1 Navigate to the Quality Center home directory, and open the \application 
folder. By default, the home directory is C:\Program Files\Mercury\
Quality Center on Windows, and /opt/Mercury/QualityCenter on Solaris, 
Linux, and AIX.

 2 Extract the contents of sabin.war into a temp file, and open the 
siteadmin.xml file in a text editor.

 3 Search for the “native” property. If its value is set to “Y”, Windows 
authentication was used. Make sure that the new installation uses the same 
authentication type (SQL Server authentication or Windows authentication) 
as the previous installation.

IIS Site Not Responding

If you are using an IIS Web server and you get a message that the IIS site is 
not responding, check that JBoss is running and that IIS was configured 
successfully.

To check that JBoss is running:

 1 Wait about 20 minutes in case the machine is slow, or JBoss and IIS are 
working slowly.

 2 Open your Web browser and type your JBoss URL. By default, this is 
http://localhost:8080/qcbin.

 3 Check if the Quality Center Welcome page is displayed.

If the Welcome page is displayed, the problem is within IIS. 

If the Welcome page is not displayed, the problem is within JBoss. Follow 
the steps described in “JBoss Does Not Start” on page 132.

To check the IIS configuration:

 1 Open the IIS manager (choose Start > Run, and type inetmgr).

 2 Select the Web site that was selected during installation. The default Web 
site used during installation is Default Web Site. For more information on 
selecting the IIS Web site, see step 17 on page 63.
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 3 Check that the Web site contains a folder named quality_center. If there is 
no quality_center folder, you must install Quality Center again.

 4 Right-click the Default Web Site directory, and click Properties.

 5 Click the ISAPI Filters tab, and check that the quality_center folder is listed 
as a filter and has a green arrow. If the filter is not enabled, install 
Quality Center again.

 6 For IIS 6.0, click the Web Service Extensions folder, and make sure that the 
QC extension exists and is allowed.

If the QC extension is not allowed, select QC and click Allow.

If the QC extension does not exist, select All unknown ISAPI extensions and 
click Allow.

JBoss Does Not Start

If you are using a JBoss application server, and you get a message that JBoss 
does not start, perform the following checks:

➤ Check that JBoss works.

➤ Check the JBoss service user.

➤ Check that there are no JBoss script errors.

➤ Check that IIS was configured successfully.

To check JBoss works:

 1 Wait about 20 minutes in case the machine is slow, or JBoss and IIS are 
working slowly.

 2 Open your Web browser and type your JBoss URL. By default, this is 
http://localhost:8080/qcbin.

 3 Check if the Quality Center Welcome page is displayed.

If the Welcome page is displayed, the problem is within IIS. 

If the Welcome page is not displayed, the problem is within JBoss. Check the 
other JBoss troubleshooting options.
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To check the JBoss service user:

 1 Open the Services control panel (choose Start > Run, and type services.msc).

 2 Right-click the Mercury Quality Center service, and click Properties.

 3 Click the Log On tab.

 4 Enter the user information and restart the service.

To check if the JBoss script has an error:

 1 Run Jboss manually. Open command window, (choose Start > Run, and type 
cmd).

 2 Change the folder to <Quality Center installation folder>/jboss/bin.

 3 Run run.bat.

 4 Check if there are any errors.

To check the IIS configuration:

 1 Open the IIS manager (choose Start > Run, and type inetmgr).

 2 Select the Web site that was given in the installer (the default is Default Web 
Site). 

 3 Check that the Web site contains a folder named quality_center. If there is 
no quality_center folder, you must install Quality Center again.

 4 Right-click the Default Web Site directory, and click Properties.

 5 Click the ISAPI Filters tab, and check that the quality_center folder is listed 
as a filter and has a green arrow. If the filter is not enabled, install 
Quality Center again.

 6 For IIS 6.0, click the Web Service Extensions tab, and make sure that the QC 
extension exists and is allowed.

If the QC extension is not allowed, select QC and click Allow.

If the QC extension does not exist, select All unknown ISAPI extensions and 
click Allow.
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Parameters of a Previous Installation are Used

When installing on UNIX type operating systems, if the parameters of a 
previous installation are used during installation, this indicates that the 
installer does not have access to the /tmp/Mercury folder and files inside it. 
If the current installation cannot override the files in the /tmp folder, the 
parameters will be incorrect.

To check permissions:

 1 Navigate to the /tmp folder, and run ls -l to check whether the installer can 
write to tmp/Mercury.

 2 Navigate to the /tmp/Mercury folder, and run ls -l again to check the 
permissions and ownership of files within this folder.
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